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Search

  

Search the Reference Guide
 
 

   

The search engine will find pages within the entire Guide.
For best results enter just one or two words:
e.g. factory, factory defaults
Searches on more than one word will be treated "as a
phrase".
The search engine will only find text exactly as entered:
e.g. entering ping will not find pinging and vice-versa
Use the asterisk (*) character for wildcard searches:
e.g. ping* will find ping and pinging
The search engine is not case-sensitive:
e.g. factory and Factory will return the same results.
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Introduction

  

Using the Reference Guide
 
This section describes how to use the Reference Guide.
 
 Introduction

Important information about the Reference Guide.
Conventions
A list of conventions that are used throughout the
Reference Guide.
Sections
A breakdown of the Reference Guide into its various
sections.
Finding Your Way Around
Find out how the Reference Guide is organised and
how to navigate around it. 
Related Documentation
Details about the other documentation that is
supplied with your Switch.
Your Comments
Instructions for sending feedback to 3Com about the
documentation that is supplied with your Switch.
Copyright and Trademarks
Copyright and trademark information.
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Introduction

  

Using the Web Interface
 
This section describes how to access and use the Web Interface.
 
 Accessing the Web Interface

Exiting the Web Interface

Understanding the Web Interface
The Banner
The Toolbar
The Navigation Tree
The Information Area
The Summary View
The Device View
The Help View

The Getting Started Pages
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Introduction

  

Using the Command Line Interface
 
This section describes how to access and use the Command Line Interface.
 
 Accessing the Command Line Interface

How Many Users Can Access the Command Line
Interface?

Exiting the Command Line Interface 

Understanding the Command Line Interface
Entering Commands
Displaying Menus
Obtaining Help

 

 

javascript:history.go(-1)


Support - Problem Solving

http://support.3com.com/infodeli/tools/switches/4900/dha1770-0aaa06/htm/support/problemsolving/problemsolving.htm[11/16/2010 9:27:46 AM]

Support

  

Problem Solving
 
This section contains a list of known problems and suggested solutions. It covers the
following topics:
 
 Web Interface Problems

Command Line Interface Problems
VLAN Problems
Link Aggregation Problems
SNMP Management Software Problems
Serial Web Utility Problems
Management Software Upgrade Problems
Software Update Utility Problems
IP Routing (Layer 3) Problems
RADIUS Problems
Other Problems

 

 
If you have a problem that is not listed here and you cannot solve it, please refer to the
3Com Knowledgebase Web Service:

http://knowledgebase.3com.com/
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Internet Support
 
Register Your Product to Gain Service Benefits

To take advantage of warranty and other service benefits, you must first register your
product at http://eSupport.3com.com/. 3Com eSupport services are based on accounts
that you create or have authorization to access. First time users must apply for a user
name and password that provides access to a number of eSupport features including
Product Registration, Repair Services, and Service Request.

Purchase Value-Added Services

To enhance response times or extend warranty benefits, contact 3Com or your
authorized 3Com reseller. Value-added services can include 24x7 telephone technical
support, software upgrades, onsite assistance or advance hardware replacement.

Experienced engineers are available to manage your installation with minimal disruption
to your network. Expert assessment and implementation services are offered to fill
resource gaps and ensure the success of your networking projects. More information on
3Com Extended Warranty and Professional Services is available at
http://www.3com.com/
Contact your authorized 3Com reseller or 3Com for additional product and support
information.

Troubleshoot Online

You will find support tools posted on the 3Com web site at http://www.3com.com/

3Com Knowledgebase helps you troubleshoot 3Com products. This query-based
interactive tool is located at http://knowledgebase.3com.com/ and contains
thousands of technical solutions written by 3Com support engineers.
Connection Assistant helps you install, configure and troubleshoot
3Com desktop and server NICs, wireless cards and Bluetooth devices.
This diagnostic software is located at:
http://www.3com.com/prodforms/software/connection_assistant/ca_thankyou.html

Access Software Downloads

Software Updates are the bug fix / maintenance releases for the version
of software initially purchased with the product. In order to access these
Software Updates you must first register your product on the 3Com web
site at http://eSupport.3com.com/.
First time users will need to apply for a user name and password. A link to
software downloads can be found at
http://eSupport.3com.com/ , or under the Product Support heading at
http://www.3com.com/.
Software Upgrades are the software releases that follow the software
version included with your original product. In order to access upgrades
and related documentation you must first purchase a service contract
from 3Com or your reseller.

Contact Us

3Com offers telephone, e-mail and internet access to technical support
and repair services. To access these services for your region, use the
appropriate telephone number, URL or e-mail address from the lists in the Support
section of this guide.
You will find a current directory of support telephone numbers posted on
the 3Com web site at http://csoweb4.3com.com/contactus/
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Support

  

Email Support
 
Some 3Com regions offer an email support service. To access this service for your
region, use the appropriate URL or email address from the list below.

Asia, Pacific Rim
From this region, email:
apr_technical_support@3com.com

Europe, Middle East and Africa
From this region, enter the URL:
http://emea.3com.com/support/email.html

Latin America
Spanish speakers, enter the URL:
http://lat.3com.com/lat/support/form.html

Portuguese speakers, enter the URL:
http://lat.3com.com/br/support/form.html

English speakers, email:
lat_support_anc@3com.com
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Telephone Support
 
Telephone Technical Support and Repair

To obtain telephone support as part of your warranty and other service benefits, you
must first register your product at http://eSupport.3com.com/

When you contact 3Com for assistance, please have the following information ready:

Product model name, part number, and serial number
A list of system hardware and software, including revision level
Diagnostic error messages
Details about recent configuration changes, if applicable

To send a product directly to 3Com for repair, you must first obtain a return
authorization number (RMA). Products sent to 3Com, without authorization numbers
clearly marked on the outside of the package, will be returned to the sender unopened,
at the sender’s expense. If your product is registered and under warranty, you can
obtain an RMA number online at http://eSupport.3com.com/. First time users will need
to apply for a user name and password.

Telephone numbers are correct at the time of publication. Find a current directory of
support telephone numbers posted on the 3Com web site at
http://csoweb4.3com.com/contactus/

Country Telephone Number Country Telephone Number
 
Asia, Pacific Rim Telephone Technical Support and Repair
Australia
Hong Kong
India

Indonesia
Japan

Malaysia
New Zealand
Pakistan

1 800 678 515
800 933 486
+61 2 9424 5179 or
000800 650 1111
001 803 61009
00531 616 439 or
03 5977 7991
1800 801 777
0800 446 398
+61 2 9937 5083

Philippines

P.R. of China

Singapore
S. Korea
Taiwan
Thailand

1235 61 266 2602 or
1800 1 888 9469 
10800 61 00137 or
021 6350 1590 or
00800 0638 3266
800 6161 463
080 333 3308
00801 611 261
001 800 611 2000

You can also obtain support in this region using the following e-mail:
apr_technical_support@3com.com 
Or request a repair authorization number (RMA) by fax using this number: + 65 543
6348
Europe, Middle East and Africa Telephone Technical Support and Repair
From anywhere in these regions, call: +44 (0)1442 435529

 
From the following countries, you may use the numbers shown:
    
Austria
Belgium
Denmark 
Finland 
France 
Germany 
Hungary
Ireland
Israel
Italy

01 7956 7124
070 700 770
7010 7289
01080 2783
0825 809 622
01805 404 747
06800 12813
01407 3387
1800 945 3794
199 161346

Luxembourg
Netherlands
Norway
Poland
Portugal
South Africa
Spain
Sweden 
Switzerland
U.K.

342 0808128
0900 777 7737
815 33 047
00800 441 1357
707 200 123
0800 995 014
9 021 60455
07711 14453
08488 50112
0870 909 3266
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You can also obtain support in this region using the following URL:
http://emea.3com.com/support/email.html

Latin America Telephone Technical Support and Repair
Antigua
Argentina
Aruba
Bahamas
Barbados
Belize
Bermuda
Bonaire
Brazil
Cayman
Chile
Colombia
Costa Rica
Curacao
Ecuador
Dominican Republic

1 800 988 2112
0 810 444 3COM
1 800 998 2112
1 800 998 2112
1 800 998 2112
52 5 201 0010
1 800 998 2112
1 800 998 2112
0800 13 3COM
1 800 998 2112
AT&T +800 998 2112
AT&T +800 998 2112
AT&T +800 998 2112
1 800 998 2112
AT&T +800 998 2112
AT&T +800 998 2112

Guatemala
Haiti
Honduras
Jamiaca
Martinique
Mexico
Nicaragua
Panama
Paraguay
Peru
Puerto Rico
Salvador
Trinidad and Tobago
Uruguay
Venezuela
Virgin Islands

AT&T +800 998 2112
571 592-5000
AT&T +800 998 2112
1 800 998 2112
571 592-5000
01 800 849CARE
AT&T +800 998 2112
AT&T +800 998 2112
54 11 4894 1888
AT&T +800 998 2112
1 800 998 2112
AT&T +800 998 2112
1 800 998 2112
AT&T +800 998 2112
AT&T +800 998 2112
571 592-5000

You can also obtain support in this region using the following:

Spanish speakers, enter the URL: 
http://lat.3com.com/lat/support/form.html
Portuguese speakers, enter the URL: 
http://lat.3com.com/br/support/form.html
English speakers in Latin America should send e-mail to:
lat_support_anc@3com.com

US and Canada Telephone Technical Support and Repair
 1 800 876 3266   
Country Telephone Number Country Telephone Number
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Introduction

  

Using the Reference Guide
 
Introduction

The Reference Guide provides all the information you need to change the way a
SuperStack® 3 Switch 4900 Family or 3Com® Switch 40x0 Family unit works using the
Gigabit Multilayer Switching software.

The guide is intended for use by network administrators who are responsible for
installing and setting up network equipment; consequently, it assumes a basic working
knowledge of LANs (Local Area Networks).

 If the information in the release notes that are shipped with your product differs
from the information in this guide, follow the instructions in the release notes.

Most user guides and release notes are available in Adobe Acrobat Reader Portable
Document Format (PDF) or HTML on the 3Com World Wide Web site:

http://www.3com.com/

Related Sections

Conventions A list of conventions that are used throughout the Reference
Guide

Sections A breakdown of the Reference Guide into its various sections
Finding Your Way Around Find out how the Reference Guide is organised and how to

navigate around it
Related Documentation Details about the other documentation that is supplied with

your Switch
Your Comments Instructions for sending feedback to 3Com about the

documentation that is supplied with your Switch
Copyright and 
Trademarks

Copyright and trademark information.
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Introduction

  

Using the Reference Guide
 
Conventions

The following tables list conventions that are used throughout the Reference Guide:

Notice Icons

Icon  Notice Type  Description
     

 Information note  
Information that describes important features or
instructions.

     

 Caution  
Information that alerts you to potential loss of data or
potential damage to an application, system, or device.

     

 Warning  Information that alerts you to potential personal injury.

Text Conventions

Convention  Description
   
Screen displays  This typeface represents information as it appears on the screen.
   
Syntax

 

The word “syntax” means that you must evaluate the syntax
provided and then supply the appropriate values for the
placeholders that appear in angle brackets. Example:

To change your password, use the following syntax:

system password <password>

In this example, you must supply a password for <password>.
   
Commands

 

The word “command” means that you must enter the command
exactly as shown and then press Return or Enter. Commands
appear in bold. Example:

To display port information, enter the following command:

bridge port detail
   
The words “enter”
and “type”  

When you see the word “enter” in this guide, you must type
something, and then press Return or Enter. Do not press Return
or Enter when an instruction simply says “type.”

   
Keyboard key names

 

If you must press two or more keys simultaneously, the key
names are linked with a plus sign (+). Example:

Press Ctrl+Alt+Del
   
Words in italics

 

Italics are used to:

Emphasize a point.
Denote a new term at the place where it is defined in the
text.
Identify menu names, menu commands, and software
button names. Examples:
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From the Help menu, select Contents. 

Click OK.

Related Sections

Introduction Important information about the Reference Guide
Sections A breakdown of the Reference Guide into its various sections
Finding Your Way Around Find out how the Reference Guide is organised and how to

navigate around it
Related Documentation Details about the other documentation that is supplied with

your Switch
Your Comments Instructions for sending feedback to 3Com about the

documentation that is supplied with your Switch
Copyright and 
Trademarks

Copyright and trademark information.
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Introduction

  

Using the Reference Guide
 
Sections

The Reference Guide is divided into the following sections:

Introduction
Using the Reference Guide
Learn how to use this Reference Guide.
Using the Web Interface 
Learn how to access and use the Web Interface.
Using the Command Line Interface
Learn how to access and use the Command Line Interface.

Command Line Interface
Learn about the Command Line Interface commands.
Web Interface
Learn about the Web Interface operations.
Support

Problem Solving
Find solutions to common problems.
Internet Support
Visit 3Com on the Internet.
Telephone Support
Contact 3Com Technical Support. 

Search
Search the Reference Guide by keyword.

Related Sections

Introduction Important information about the Reference Guide
Conventions A list of conventions that are used throughout the Reference

Guide
Finding Your Way Around Find out how the Reference Guide is organised and how to

navigate around it
Related Documentation Details about the other documentation that is supplied with

your Switch
Your Comments Instructions for sending feedback to 3Com about the

documentation that is supplied with your Switch
Copyright and 
Trademarks

Copyright and trademark information.
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Introduction

  

Finding Your Way Around
 
General Navigation

  

 
Back Button - Takes you back to the previous page that you
visited. You can also use the Back button on your Web Browser to
do this.

   

 Contents Button - Takes you to the Contents page, which is the
first page that you see when the Reference Guide is opened.

   

 Back to Top button - Takes you to the top of the current page.

   

  
Related Sections/Operations/Commands - Most reference
pages have a Related section at the bottom which contains links
to other associated pages. You can use these links to quickly
access related information.

Navigating the CLI and Web Interface Reference Pages

 

You can navigate through the Web Interface
reference pages in two different ways. 
View Web Interface By Operations mirrors
the Navigation Tree in the Web Interface and
displays the same options. This is helpful if you
know which operation you want to find out
more about. 
View Web Interface By Task displays a list of
tasks that you can perform using the Web
Interface. This is helpful if you know what
specific task you want to find out more about.

   

 

You can navigate through the Command Line
Interface reference pages in two different ways.
View CLI By Commands mirrors the structure
of the Command Line Interface and displays the
same options. This is helpful if you know which
command you want to find out more about. 
View CLI By Task displays a list of tasks that
you can perform using the Command Line
Interface. This is helpful if you know what
specific task you want to find out more about.

Related Sections

Introduction Important information about the Reference Guide
Conventions A list of conventions that are used throughout the Reference

Guide
Sections A breakdown of the Reference Guide into its various sections
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Related Documentation Details about the other documentation that is supplied with
your Switch

Your Comments Instructions for sending feedback to 3Com about the
documentation that is supplied with your Switch

Copyright and 
Trademarks

Copyright and trademark information.
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Introduction

  

Using the Reference Guide
 
Related Documentation

In addition to this guide, each Switch documentation set includes the following:

Management Quick Reference Guide
This guide contains:

a list of the features supported by the Switch.
a summary of the Web interface operations and CLI (Command Line
Interface) commands that enable you to manage the Switch.

Getting Started Guide 
This guide contains:

all the information you need to install and set up the Switch in its default
state
information on how to access the management software to begin managing
the Switch.

Switch Implementation Guide
This guide provides management information with reference to product features
and network scenarios. It is supplied on the CD-ROM that accompanies your
Switch or is on the 3Com Web site.
Release Notes 
These notes provide information about the current software release, including new
features, modifications, and known problems.

There are other publications you may find useful:

Documentation accompanying the Advanced Redundant Power system.
Documentation accompanying the Expansion Modules.
Documentation accompanying 3Com Network Supervisor. This is supplied on the
3Com Website.

Related Sections

Introduction Important information about the Reference Guide
Conventions A list of conventions that are used throughout the Reference

Guide
Sections A breakdown of the Reference Guide into its various sections
Finding Your Way Around Find out how the Reference Guide is organised and how to

navigate around it
Your Comments Instructions for sending feedback to 3Com about the

documentation that is supplied with your Switch
Copyright and 
Trademarks

Copyright and trademark information.
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Using the Reference Guide
 
Your Comments

Your suggestions are very important to us. They will help make our documentation more
useful to you. Please e-mail comments about this guide and the documentation that
accompanies your Switch to 3Com at:

pddtechpubs_comments@3com.com

Please include the following information when commenting:

Document title
Document part number (on the title page)
Page number (if appropriate) or the URL

Example:

SuperStack 3 Switch 4900 Family Getting Started Guide
Part Number DUA1770-0AAA0x
Page 21

 Please note that we can only respond to comments and questions about 3Com
product documentation at this e-mail address. Questions related to technical support or
sales should be directed in the first instance to your network supplier.

Related Sections

Introduction Important information about the Reference Guide
Conventions A list of conventions that are used throughout the Reference

Guide
Sections A breakdown of the Reference Guide into its various sections
Finding Your Way Around Find out how the Reference Guide is organised and how to

navigate around it
Related Documentation Details about the other documentation that is supplied with

your Switch
Copyright and 
Trademarks

Copyright and trademark information.
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Using the Reference Guide
 
Copyright and Trademarks

© 3Com Corporation, 2003. All rights reserved. No part of this documentation may be
reproduced in any form or by any means or used to make any derivative work (such as
translation, transformation, or adaptation) without permission from 3Com Corporation.

3Com Corporation reserves the right to revise this documentation and to make changes
in content from time to time without obligation on the part of 3Com Corporation to
provide notification of such revision or change.

3Com Corporation provides this documentation without warranty of any kind, either
implied or expressed, including, but not limited to, the implied warranties of
merchantability and fitness for a particular purpose. 3Com may make improvements or
changes in the product(s) and/or the program(s) described in this documentation at any
time.

UNITED STATES GOVERNMENT LEGENDS:
If you are a United States government agency, then this documentation and the
software described herein are provided to you subject to the following restricted rights:

For units of the Department of Defense: 
Restricted Rights Legend: Use, duplication or disclosure by the Government is subject to
restrictions as set forth in subparagraph (c) (1) (ii) for restricted Rights in Technical Data
and Computer Software clause at 48 C.F.R. 52.227-7013. 3Com Centre, Boundary Way,
Maylands Park South, Hemel Hempstead, Herts, HP2 7YU, U.K.

For civilian agencies:
Restricted Rights Legend: Use, reproduction or disclosure is subject to restrictions set
forth in subparagraph (a) through (d) of the Commercial Computer Software - Restricted
Rights Clause at 48 C.F.R. 52.227-19 and the limitations set forth in 3Com Corporation’s
standard commercial agreement for the software. Unpublished rights reserved under the
copyright laws of the United States.

If there is any software on removable media described in this documentation, it is
furnished under a license agreement included with the product as a separate document,
in the hard copy documentation, or on the removable media in a directory file named
license.txt. If you are unable to locate a copy, please contact 3Com and a copy will be
provided to you.

Unless otherwise indicated, 3Com registered trademarks are registered in the United
States and may or may not be registered in other countries.

3Com and SuperStack are registered trademarks of 3Com Corporation. XRN is a
trademark of 3Com Corporation.

Other brand and product names may be registered trademarks or trademarks of their
respective holders.

This [Licensee Product] contains Macromedia Flash™ Player software by
Macromedia, Inc., Copyright © 1995-1999 Macromedia, Inc.
All rights reserved.
Macromedia and Flash are trademarks of Macromedia, Inc.

Related Sections

Introduction Important information about the Reference Guide
Conventions A list of conventions that are used throughout the Reference

Guide
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Introduction

  

Using the Web Interface
 
Accessing the Web Interface

You can access the web interface through the console port on your Switch or over the
network.

To access the web interface through the console port, you must install, configure and
run the Serial Web Utility described in the accompanying readme file on the CD-ROM.
Note that the Serial Web Utility is only required if you want to access the web interface
through the console port; it is not required for access over the network.

To access the web interface over the network, take the following steps:

1. Ensure that your network is correctly set up for management using the web
interface. For more information, see "Setting Up Web Interface Management" in the
Switch Getting Started Guide.

2. Open your Web browser.

3. In the Location field of the browser, enter the URL of the Switch. This must be in
the format: http://nnn.nnn.nnn.nnn/ where nnn.nnn.nnn.nnn is the IP address
of the Switch. When the browser has located the Switch, a user name and
password dialog box is displayed.

 

 If the user name and password dialog box is not displayed, see Solving Web
Interface Problems.

4. Enter your user name and password:

If you have been assigned a user name and password, enter those details.
If you are accessing the web interface for the first time, enter a default user
name and password to match your access requirements. The defaults are
described in “Logging in as a Default User” in the Switch Getting Started
Guide. If you are setting up the Switch for management, we suggest that
you log on as admin (which has no default password).

To prevent unauthorized configuration of the Switch, we recommend that you
change the default passwords as soon as possible. To do this using the web
interface, you need to log in as each default user and then follow the steps
described in Changing Your Password.

 If you forget your password while logging in to the web interface, see Solving
Web Interface Problems.
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Once you have entered a correct user name and password, one of two events
occur:

If you are accessing the web interface for the first time, a set of Getting
Started pages are displayed. These are described in Accessing the Getting
Started Pages.
If you have accessed the web interface before, the main web interface is
displayed. For information about the interface, see The Main Web Interface.

If you are unable to access the web interface, see Solving Web Interface
Problems.

 While you are managing the Switch, you can display other web pages
using your browser, and then simply use the Back button to reload the web
management pages. You do not need to re-enter your username and
password.

How Many Users Can Access the Web Interface?

The web interface can be accessed by any number of users at the same time.

Exiting the Web Interface

You can exit the web interface at any time; to do this, close your Web browser. For
security reasons, you should always close your Web browser after a management
session.

Related Sections

Understanding The Web Interface

 

The Banner
The Toolbar
The Navigation Tree
The Information Area
The Summary View
The Device View
The Help View

The Getting Started Pages
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Introduction

  

Using the Web Interface
 
Understanding the Web Interface

The web manangement interface is made up of four areas:

The Banner
This is always displayed at the top of the browser window. It displays the name of
the Switch. For more information, see The Banner.
The Toolbar
This is always displayed at the top of the browser window, underneath the Banner.
It contains three buttons which allow you to select different views in the View
Area. For more information, see The Toolbar.
The Navigation Tree
This is always displayed on the left side of the browser window. It contains various
icons which allow you to manage your network. For more information, see The
Navigation Tree.
The Information Area
This is always displayed on the right side of the browser window. It contains
information about the managed network. For more information, see The
Information Area.

Related Sections

Accessing the Web Interface
Exiting the Web Interface

 

The Banner
The Toolbar
The Navigation Tree
The Information Area
The Summary View
The Device View
The Help View

The Getting Started Pages
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Introduction

  

Using the Web Interface
 
The Banner

The Banner is always displayed at the top of the browser window. It displays the 3Com
logo and 3Com product name.

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Toolbar
The Navigation Tree
The Information Area
The Summary View
The Device View
The Help View

The Getting Started Pages
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Introduction

  

Using the Web Interface
 
The Toolbar

The Toolbar is always displayed at the top of the browser window, underneath the
Banner. It contains three buttons which allow you to select different views:

Summary
Click the Summary button to display the Summary View. This view allows you to
update the latest summary information for the Switch. For more information, see
The Summary View.

Device View
Click the Device View button to display the Device View. This view allows you to
perform configuration and monitoring on a system-wide, unit-wide or port-wide
basis. For more information, see The Device View.

Help
Click the Help button to display the Help view. This view allows you to access
additional information from the 3Com website and provides specification guidelines
for running the Web Interface. For more information, see The Help View.

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Banner 
The Navigation Tree
The Information Area
The Summary View
The Device View
The Help View

The Getting Started Pages
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Using the Web Interface
 
The Navigation Tree

The Navigation Tree is always displayed on the left side of the browser window. It is a
Windows® Explorer-like interface that contains various icons which allow you to manage
your network.

By default, when you open the Web Interface, the Summary View is selected and the
Navigation Tree is fully collapsed with only the top-level options displayed.

Operations that you can perform to manage your network are grouped into folders within
the Navigation Tree in the Device View. You can also perform some operations by using
the device mimic.

Single-click the folders or the nodes (the plus and minus symbols) to expand and
collapse the Navigation Tree.

 Every option within the Navigation Tree is selected by single-clicking the left mouse
button.

The following table shows the various Navigation Tree symbols and their associated
behaviour:

Symbol  Behavior
  

 

Indicates that the next level of the Navigation Tree hierarchy is
currently expanded. Click the symbol to collapse the next level. This
only affects the Navigation Tree — no changes are made to the
Information Area.

   

 

Indicates that the next level of the Navigation Tree hierarchy is
currently collapsed. Click the symbol to expand the next level to its
last expanded state. This only affects the Navigation Tree — no
changes are made to the Information Area.

   
Indicates that the next level of the Navigation Tree hierarchy is
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currently expanded. Click the symbol to collapse the next level. This
only affects the Navigation Tree — no changes are made to the
Information Area.

   

 

Indicates that the next level of the Navigation Tree hierarchy is
currently collapsed. Click the symbol to expand the next level. This
only affects the Navigation Tree — no changes are made to the
Information Area.

   

 
Click the symbol to update the Information Area with the latest
summary information for the Switch. This symbol is only available in
the Summary View.

  

 
Click the symbol to perform an operation by opening a new window.
This only affects the Navigation Tree — no changes are made to the
Information Area.

  
 Click the symbol to open a Wizard in a new window. This only affects

the Navigation Tree — no changes are made to the Information Area.
  
 Click the symbol to update the Information Area with Summary and

device mimic information about the particular unit.
  
 Click the symbol to launch a Help operation. This only affects the

Navigation Tree — no changes are made to the Information Area.

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Banner
The Toolbar
The Information Area
The Summary View
The Device View
The Help View

The Getting Started Pages
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Introduction
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The Information Area

The Information Area is always displayed on the right side of the browser window. It
contains information about the managed network.

If the Summary View is currently selected, a series of tables is displayed which show
summary information for the Switch.

If the Device View is currently selected, the device mimic and the Device Summary table
are displayed.

If the Help View is currently selected, specification guidelines for running the Web
Interface are displayed.

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Banner
The Toolbar
The Navigation Tree
The Summary View
The Device View
The Help View

The Getting Started Pages
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Using the Web Interface
 
The Summary View

Click the Summary button on the Toolbar to access the Summary View.

Click the System icon in the Navigation Tree to update the Information Area with the
latest summary information for the Switch and the units within it.

The summary information is displayed in a series of tables:

System Summary
The first table is entitled System Summary and displays information for the Switch.
It shows the System Name, Location, Contact and Up Time.
Device Summary
This table displays information for the Switch. It shows the Unit Name, Type,
Software Version, Hardware Version and IP Address.

 The Summary View only displays information for the Switch. You cannot perform any
operations from this view. You must use the Device View to perform operations.

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Banner
The Toolbar
The Navigation Tree
The Information Area 
The Device View
The Help View

The Getting Started Pages
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Using the Web Interface
 
The Device View

Click the Device View button on the Toolbar to access the Device View. This view allows you to
perform configuration and monitoring on a system-wide, unit-wide or port-wide basis.

For example purposes only, this figure shows a 3Com Switch 4050.

The Device View Navigation Tree is displayed on the left side of the browser window and
allows you to perform all operations for the Switch.

 For more information about the operations that you can perform, see the Web Interface -
Operations page.

The Device View Information Area is displayed on the right side of the browser and contains
the device mimic and the Device Summary table.

Device Mimic
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For example purposes only, this figure shows a 3Com Switch 4050.

The device mimic is an interactive representation of the currently selected unit. It is
periodically updated to reflect changes in the unit, particularly changes made to the status of
its ports. You can also perform certain operations by clicking on parts of the device mimic
called "hotspots":

Port Hotspots
Each port on the mimic, including the console port, is a "hotpsot". Click a port to open a
pop-up menu that contains operations which you can launch for that particular port.
The operations are:

Setup
Statistics

Unit Hotspot
The non-port area of the mimic is a "hotspot". Click anywhere on this area to open a
pop-up menu that contains operations which you can launch for the unit as a whole.
The operations are:

Name
Notepad
History-1 Hour
History-48 Hours
Summary
Setup

The device mimic also has four Controls, which are text areas that you can use to control the
mimic and its appearance and to provide help information:

Polling Interval - Click this to set the rate at which the device mimic is refreshed.
Poll Now - Click this to refresh the mimic now.
Display Filter - Click this to control how the port status is displayed.
Color Key - Click this for an explanation of the symbols and colours on the mimic's
ports.

Device Summary
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For example purposes only, this figure shows a 3Com Switch 4050.

A table entitled Device Summary shows the Name, Type, Software Version, Hardware Version,
IP Address, MAC Address, Boot Version, Serial Number, Up Time and other information for the
Switch.

Device Mimic States

The Web Interface management software on the Switch displays the Device Mimic, which is an
interactive representation of the currently selected unit. The following port states are
displayed:

Status

Meaning
10/100/

1000
1000SX

GBIC
1000SX

GBIC
1000LX/LH

SFP
1000SX

SFP
1000LX/LH  

Link down,
enabled  

Link down,
disabled  

Link up,
enabled  

Link up,
enabled,
reduced
speed

      

Link up,
disabled  

Current
display filter  

Link up,
operating as
a Fabric port

     

The following additional states are displayed for any GBIC or SFP:

Meaning GBIC Status SFP Status
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Empty transceiver slot, port enabled

Empty transceiver slot, port disabled

Invalid, unrecognized or faulty transceiver
fitted

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Banner
The Toolbar
The Navigation Tree
The Information Area
The Summary View
The Help View

The Getting Started Pages
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The Help View

Click the Help button on the Toolbar to access the Help View. This view allows you to
access additional information from the 3Com website and provides specification
guidelines for running the Web Interface.

The Help View Navigation Tree contains four options that allow you to access additional
information from the 3Com website. Your management workstation must have access to
the World Wide Web for these options to work:

Click the Contacts icon to display contact information from the 3Com World Wide
Web site in a new browser window.
Click the Home Page icon to display the Home page of the 3Com World Wide Web
site in a new browser window.
Click the Library icon to display the Online Library of the 3Com World Wide Web
site in a new browser window.
Click the Support icon to display support information from the 3Com World Wide
Web site in a new browser window.

The Help View Information Area provides specification guidelines for running the Web
Interface. It is recommended that you access the Web Interface using the suggested
Web Browsers and PC Platforms.

Related Sections

Accessing the Web Interface
Exiting the Web Interface
Understanding The Web Interface

 

The Banner
The Toolbar
The Navigation Tree
The Information Area
The Summary View
The Device View

The Getting Started Pages
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System Getting Started
 
The Getting Started Pages

When you access the web interface for the first time or after a power-off/on cycle, a set
of Getting Started pages are displayed. The Getting Started pages allow you to enter
basic setup information for the Switch. The Getting Started pages are also available from
the main web interface at any time.

To access the Getting Started pages:

1. Click Device View on the Toolbar.

2. Select System -> Getting Started in the Navigation Tree. 

The first Getting Started page is displayed.

As you go through the pages, you need to enter:

1. A descriptive name for the Switch.

2. The physical location of the Switch.

3. The name of a person to contact about the Switch.

4. Whether you want to:

- manually configure IP information for the Switch 
- automatically configure IP information for the Switch
- disable the LAN interface
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 The Switch has three automatic IP configuration methods that it tries in turn,
these are: DHCP, Auto-IP and BOOTP. For detailed information on how the
automatic IP configuration process works, please refer to the Implementation
Guide that accompanies your Switch.

Automatic is the default setting for IP configuration. If you select Automatic IP
configuration, no further prompts are displayed.

If you choose to manually configure the IP information, you are prompted to enter
the following:

IP Address
Allows you to enter a unique IP address for the Switch.

 If you change the IP address of the Switch, you can no longer access the web
interface unless you enter the new IP address in the Location Address field of your
browser.

Subnet Mask
Allows you to enter a subnet mask for the Switch.

Default Gateway (router)
If your network contains one or more gateways, this field allows you to enter the
IP address of the default gateway.

5. If you select None, no further prompts are displayed.

6. A new password for the current user (enter the existing password if you want to
leave the password unchanged).
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Using the Command Line Interface
 
Accessing the Command Line Interface

To access the command line interface, take the following steps:

1. Set up your network for command line interface management; for more
information, see “Setting Up Command Line Interface Management” in the Switch
Getting Started Guide. The login sequence for the command line interface begins
as soon as the Switch detects a connection to its console port, or as soon as a
Telnet session is started.

 If the login sequence does not begin immediately, press the [Return] key a few
times until it does begin. If the sequence still does not begin, see Solving
Command Line Interface Problems.

2. At the login and password prompts, enter your user name and password:

If you have been assigned a user name and password, enter those details.
If you are accessing the command line interface for the first time, enter a
default user name and password to match your access requirements. The
defaults are described in “Logging in as a Default User” in the Switch Getting
Started Guide. If you are setting up the Switch for management, we suggest
that you log in as admin (which has no default password).

If you have logged on correctly, the top-level menu of the command line interface
is displayed as described in About the Interface Menus. If you have not logged on
correctly, the message Incorrect password. is displayed and the login sequence
starts again.

 To prevent unauthorized configuration of the Switch, we recommend that you
change the default passwords as soon as possible. To do this using the command
line interface, you need to log in as each default user and then follow the steps
described in Changing Your Password.

How Many Users Can Access the Command Line Interface?

The command line interface can be accessed by any number of users at the same time.
If the Switch is being managed using Telnet, the command line interface can be
accessed by any number of users at the same time.

Exiting the Command Line Interface

You can exit the command line interface at any time; to do this, enter the command
logout from the top level of the command line interface. If there is a period of inactivity
lasting longer than 30 minutes, you are logged out of the command line interface
automatically. After the exit, the first key that you press returns you to the login
sequence.

Related Sections

Understanding the Command Line Interface

 
Entering Commands
Displaying Menus
Obtaining Help
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Using the Command Line Interface
 
Understanding the Command Line Interface

Once you access the command line interface, the Top-level menu is displayed as shown in
the example screen below:

The command line interface is made up of two areas:

The Menu Area — Contains the current menu of commands. The menu can contain
commands to configure the stack or commands to display other menus in the
command line interface. Each command is accompanied by a brief description of its
purpose.
The Command Area — Contains a Select menu option: prompt where you can
enter the commands displayed in the menu area.

From the Top-level menu, you can access these sub-menus:

Bridge menu
This menu contains commands that allow you to administer the bridging functions
of the Switch, such as link aggregation, multicast filtering, and VLANs.
Fabric menu
This menu contains commands that allow you to configure a SuperStack 3 Switch
4900 GBIC Module (3C17714) to operate in XRN mode.
Feature menu
This menu contains commands that allow you to administer system features such as
roving analysis or Webcache support.
GettingStarted menu
This menu contains a command that allows you to perform the basic configuration
of the Switch.
Logout
This menu contains a command that allows you to logout of the Command Line
Interface.
PhysicalInterface menu 
This menu contains commands that allow you to enable or disable the ports in the
Switch, and view status information about them.
Protocol menu 
This menu contains commands that allow you to view and change IP-related
information for the Switch and ping other devices in your network.
Security menu 
This menu contains commands that allow you to view and change security-related
information for the Switch and the network.
System menu 
This menu contains commands that allow you to view and configure information
about the Switch units in the Distributed Fabric or the Distributed Fabric as a whole.
TrafficManagement menu
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This menu contains commands that allow you to administer quality of service.

Entering Commands

The command area of the command line interface contains a Select menu option
prompt that allows you to enter the commands in the menu area.

 Commands are not case-sensitive.

To enter a simple command:
At the prompt, enter the name of the command.

To enter multiple commands: 
At the prompt, enter each command in succession. For example, to display the
system menu and reset the Switch units in the stack, enter:

system reset 

To enter commands that require values: 
Append the values to the name of the command. For example, to display the
system menu and change your password, enter:

system password <password>

If you do not specify values for a command that requires them, you are prompted
to enter the values. At each prompt, the default value is displayed in brackets.

To enter multiple commands that require password values:
At the prompt, enter each command in succession, then append the password to
the name of the command. If the password contains spaces, surround it with quote
marks. If the password does not contain spaces, you do not have to use quote
marks.

For example, to display the system menu and change your password, enter:

system management password "my new password" (contains spaces)

or

system management password mynewpassword (no spaces)

To enter abbreviated commands:
At the prompt, enter enough characters to uniquely identify the commands. For
example, to display the system menu and then change the password for your user,
enter:

sy pa <password>

To apply commands to a range of ports:
There are some commands, for example, physicalInterface ethernet portMode
command that you may wish to apply to multiple ports in a Switch unit or a stack.
Once you have entered enough characters to uniquely identify the command a
prompt will display similar to the example below: 

Select Ethernet port (unit:port....,?):

You can enter the ports at this prompt using the correct notation, or enter ?, which
will display an example of how to enter a range of ports and detail the available
ports that you can apply the command to. Entering ? will display a prompt similar
to the example below (if the command does not produce such a prompt, then that
command can only be applied to a specific port and not to a range of ports):
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Example comma separated list: 1:1-2,2:3-4:5
Available ports for this command are: 1:1-1:12,2:1-2:12

The correct notation for entering a range of commands is as shown in the example
table below:

Single port Unit 1 Port 4 1:4

 Unit 2 Port 6 2:6

Range of ports with no gaps Unit 3 Ports 5-10 3:5-3:10 *

 Unit 3 Port 5 - Unit 4 Port 8 3:5-4:8

Range of ports with gaps Unit 1 Ports 3-5 and Unit 2 Ports 8-10 1:3-5,2:8-10

* Note that 3:5-10 is also permitted; the second unit ID in a range is optional if
the same as the first unit ID.

Important notes:
You need to use the unit:port notation even if there is only a single Switch in
the stack (the unit ID is 1). You cannot enter the port number only.

These ranges can be used with shortened command forms to produce
powerful single line commands when using the comma separated list syntax.
For example, to disable ports 13-24 on all units in a stack of 4 Switches can
be shortened to:

phy eth portstate 1:13-24,2:13-24,3:13-24,4:13-24 disable

If you enter a port, or a range where some ports are not a valid selection, a
message "x:x" is not a valid selection." is returned. All ports or port
ranges that you enter must be valid for the command to apply.

Displaying Menus

There are several ways to display the menus in the command line interface menu
structure:

To display sub-menus:
At the Select menu option prompt, enter the name of the menu or menus.

To display parent menus:
At the Select menu option prompt, enter q.

To display the Top-level menu: 
Press the [Esc] key.

Obtaining Help

You can access the command line interface help system at any time by entering ? at the
Select menu option prompt.

Related Sections

Accessing the Command Line Interface
How Many Users Can Access the Command Line Interface?
Exiting the Command Line Interface
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Support

  

Problem Solving
 
Solving Web Interface Problems

 What is the default IP address of the Switch?
How to configure an IP address on your Switch.

 To manage a Switch using the web interface over a network, you must
set up the Switch with IP information.

To do this:

1. You must connect a terminal or terminal emulator to the console
port correctly. If you are connecting directly to the console port,
you need a standard null modem cable. The console port of the
Switch has a male 9-pin d-type connector. You can find pin-out
diagrams for both cables in the Getting Started Guide that
accompanies your Switch. 

2. To connect the cable:

1. Attach the female connector on the cable to the male
connector on the console port of the Switch.

2. Connect the other end of the cable to your terminal,
terminal emulator, or modem.

3. Open a terminal emulator (such as HyperTerminal) with the
following settings: 

baud rate 19200

8 data bits

no parity

1 stop bit

No Flow Control

VT100 Emulation

4. Login as admin with no password, or security with the password
security.

5. At the Top-level menu, enter: 

protocol ip basicConfig

You will then be prompted for the following details:

Enter IP address [0.0.0.0]: Enter a valid IP address.

Enter subnet mask [0.0.0.0]: Enter a subnet mask, if
required. 

Enter gateway ip address [0.0.0.0]: 

6. Logout.
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You should now be able to connect to the Switch via the web interface.

 The Web browser cannot access the Switch over the network.

 Ensure that, if you are managing the Switch over the network, remote
access to the management software of the Switch is enabled. For more
information, see Enabling and Disabling Remote Access.

 The Web browser cannot access the Switch over a serial link from
a management station running Windows® 95/98/2000/NT.

 You must access the Switch using the 3Com Serial Web Utility; see the
readme file that accompanies the Serial Web Utility on the CD-ROM.

 The Web browser can no longer access the Switch over the
network.

 Ensure that:

Remote access to the management software of the Switch is
enabled. For more information, see Enabling and Disabling
Remote Access.

The port through which you are trying to access the Switch is
enabled. For more information, see The Device View, or if the
port is enabled, check the connections and network cabling for
the port.

The port through which you are trying to manage the Switch
belongs to the Default VLAN (VLAN 1). This is the only VLAN that
can be used to access the management software of the Switch.

If there is still a problem, try accessing the Switch through a different
port. If you can now access the Switch, a problem may have occurred
with the original port. Contact your supplier for further advice.

 You forget the password for the "admin" user account and can no
longer perform important management operations.

 Use the password recovery method outlined below to define a new
password for the "admin" user account:

1. Access the Command Line Interface and enter the user name
"recover" and password "recover" to place the Switch in password
recovery mode. The Switch remains in password recovery mode
for a maximum of 30 seconds, before it returns to the CLI login
prompt.

2. Perform a hard reset on the Switch whilst it is in password
recovery mode by switching it off, waiting a few seconds, and
switching it on again.

 If the Switch has a Redundant Power Supply (RPS) connected,
you will need to disconnect it in order to perform a hard reset.

 You cannot use a soft reset operation to reset the password
of the "admin" user account. This will end the password recovery
procedure and return you to the CLI login prompt.

3. When the Switch has rebooted following the hard reset enter a
new password for the "admin" user account.
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4. Enter enable to leave password recovery enabled. You are now
logged in as the default "admin" user.

 CAUTION: If you disable Password Recovery for a Switch
and subsequently forget the password for the "admin" user
account, you will have to return the Switch to 3Com.

 Password recovery can be enabled or disabled at any time by
accessing the CLI and using the security device user pwdRecover
command.

 Password recovery cannot be performed using a SLIP (Serial Line
Internet Protocol) connection.

 You forget your password and cannot log in.

 You must ask a user with Security access level to log in to a Switch via
the Command Line Interface and change the password of your account.
They must use the security device user modify command to change
the password.

 Some of the web interface is not displayed in the Web browser
after downloading.

 This is probably due to large amounts of traffic on the network. Either
reload the web interface page, or click in the part of the interface that
has not displayed and select the reload frame option in your Web
browser.

 The web interface responds slowly to commands.

 This is probably due to large amounts of traffic on the network. Either
reload the web interface page, or click in the part of the interface that
has not displayed and select the reload frame option in your Web
browser.

 "URL not found" messages are displayed when the Contacts,
Home Page, Library or Support icons in the Help View are clicked.

 Your management workstation cannot access the World Wide Web.
Contact your network administrator.
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Problem Solving
 
Solving Command Line Interface Problems

 What is the default IP address of the Switch?
How to configure an IP address on your Switch.

 To manage a Switch using the command line interface over a network
using Telnet, you must set up the Switch with IP information.

To do this:

1. You must connect a terminal or terminal emulator to the console
port correctly. If you are connecting directly to the console port,
you need a standard null modem cable. The console port of the
Switch has a male 9-pin d-type connector. You can find pin-out
diagrams for both cables in the Getting Started Guide that
accompanies your Switch. 

2. To connect the cable:

a) Attach the female connector on the cable to the
male connector on the console port of the Switch.

b) Connect the other end of the cable to your
terminal, terminal emulator, or modem.

3. Open a terminal emulator (such as HyperTerminal) with the
following settings: 

baud rate 19200

8 data bits

no parity

1 stop bit

No Flow Control

VT100 Emulation

4. Login as admin with no password, or security with the password
security.

5. At the Top-level menu, enter: 

protocol ip basicConfig

You will then be prompted for the following details:

Enter IP address [0.0.0.0]: Enter a valid IP address.

Enter subnet mask [0.0.0.0]: Enter a subnet mask, if
required. 

Enter gateway ip address [0.0.0.0]: 

6. Logout.
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You should now be able to connect to the Switch via Telnet.

 You cannot access the Switch through the console port.

 If you are experiencing difficulties in accessing the switch via the
console port, check that:

You are using a null modem cable as described in the Getting
Started Guide that accompanies your Switch.

The port settings on the terminal emulator (such as
HyperTerminal) are set as follows:

baud rate 19200

8 data bits

no parity

1 stop bit

No Flow Control

VT100 Emulation

The correct COM port has been selected.

You have configured your Switch with IP information.

 The terminal or terminal emulator cannot access the Switch.

 Ensure that, if you are managing the Switch over the network:

Remote access to the management software of the Switch is
enabled.

The port through which you are trying to manage the Switch
belongs to the Default VLAN (VLAN 1). This is the only VLAN that
can be used to access the management software of the Switch.

If the User Name and Password login prompt still does not display,
reset the Switch.

 The terminal or terminal emulator can no longer access the
Switch over the network.

 Ensure that:

Remote access to the management software of the Switch is
enabled. 

The port through which you are trying to access the Switch has
not been disabled. If it is enabled, check the connections and
network cabling for the port. 

The port through which you are trying to manage the Switch
belongs to the Default VLAN (VLAN 1). This is the only VLAN that
can be used to access the management software of the Switch.

If there is still a problem, try accessing the Switch through a different
port. If you can now access the Switch, a problem may have occurred
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with the original port. Contact your supplier for further advice.

 You cannot access the command line interface using Telnet or
Hyperterminal.

 Accessing the Command Line Interface via Telnet or Windows
HyperTerminal using TCP/IP may not work correctly on some platforms
unless the application has been configured to send line feeds with
carriage returns.

To set this for Telnet enter set CRLF when in command mode.
To set this for HyperTerminal click on the Settings tab in the
Properties screen, click ASCII Setup and ensure that Send line
ends with line feeds is checked within the ASCII Sending section.

If this does not solve the problem try an alternative Telnet application
to ensure it is not a limitation of your Telnet application.

 You should not configure HyperTerminal in the above way if you are
using a console cable to make a direct connection to the Switch.

 The command line interface responds slowly to commands.

 This is probably due to large amounts of traffic on the network. Logout
and then login to the command line interface.

 You forget the password for the "admin" user account and can no
longer perform important management operations.

 Use the password recovery method outlined below to define a new
password for the "admin" user account:

1. Access the Command Line Interface through the console port and
enter the user name "recover" and password "recover" to place
the Switch in password recovery mode. The Switch remains in
password recovery mode for a maximum of 30 seconds, before it
returns to the CLI login prompt.

2. Perform a hard reset on the Switch whilst it is in password
recovery mode by switching it off, waiting a few seconds, and
switching it on again.

 If the Switch has a Redundant Power Supply (RPS) connected,
you will need to disconnect it in order to perform a hard reset.

 You cannot use a soft reset operation to reset the password
of the "admin" user account. This will end the password recovery
procedure and return you to the CLI login prompt.

3. When the Switch has rebooted following the hard reset enter a
new password for the "admin" user account.

4. You are now logged in as the default "admin" user.

 CAUTION: If you disable Password Recovery for a Switch
and subsequently forget the password for the "admin" user
account, you will have to return the Switch to 3Com.
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 Password recovery can be enabled or disabled at any time by
accessing the CLI and using the security device user pwdRecover
command.

 Password recovery cannot be performed via a SLIP (Serial Line
Internet Protocol) connection.

 You forget your password and cannot log in.

 You must ask a user with Security access level to log in to a Switch via
the Command Line Interface and change the password of your account.
They must use the security device user modify command to change
the password.
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Solving VLAN Problems

 No traffic will pass between the VLANs, or endstations cannot
connect to a server on a different VLAN.

 To allow different VLANs on the same Switch to communicate with each
other, there are several different options, most of which use some form
of tagging.

The Switch supports 802.1Q tagging. Both sides of the link,
however, must support tagging, so if you want endstations on
different VLANs to connect to a single server, then the Network
adapter card in the server must also support 802.1Q tagging
(3Com's 3c980 server NIC supports this).

Upgrade your Switch to layer 3 functionality. 

It is also possible to connect the Switch to a layer 3 Switch that
supports 802.1Q tagging. This will enable you to provide VLAN
routing capabilities for the Switch.

When operating in a layer 3 environment, all VLANs must have an
IP address defined. Make sure that all VLANs have an IP address
defined.

When operating in a layer 3 environment, it is possible that traffic
is blocked by a deny rule in the access list. Check the access list
for any deny rules that maybe blocking the traffic.

Check that the network traffic does support the IP protocol. If it
is not IP traffic, you will need an external layer 3 device that
does support the appropriate protocol.

For further details about configuring VLANs, refer to the Implementation
Guide that accompanies your Switch.

 You have specified that an endstation generates traffic that has a
high priority, but when it passes through the network this priority
information is lost.

 The endstation is attached to a Switch port using an untagged VLAN
connection, and the Switch is removing the priority information when it
is forwarded to other untagged ports. To maintain the priority
information, specify that all untagged Switch ports use 802.1Q tagging.

 You have connected a Switch to a device using an 802.1Q tagged
link, and you can no longer access the management software of
the device or the devices connected to that device.

 You may have connected to a device that only supports 802.1Q tagged
links and have not specified that VLAN 1 traffic uses 802.1Q tagging.
Specify that VLAN 1 traffic is 802.1Q tagged, and try accessing the
devices again.

 You have connected an endstation to the Switch on a certain
VLAN, and although the Switch is a member of that VLAN and you
can see (via the LED) that the port is sending traffic, the
endstation acts as though it is not receiving the traffic.

 The port may have been configured in the correct VLAN, but if the port
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is a tagged member and the endstation does not support tagged VLANs
then the endstation will ignore the tagged traffic.

To ensure that traffic is passed across the VLAN from the Switch to the
endstation, configure the Switch port as an untagged member of the
relevant VLAN.

 Your Switch should be operating as an IGMP Querier, but it is not
sending query packets to the network.

 Check that the Switch does not have the IP address 0.0.0.0. If it does,
change the IP address, and re-enable IGMP Multicast Learning.
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Link Aggregation Problems

 You changed the partnerID of an aggregation and all the member
ports that you added have disappeared.

 Ports will only become members of an aggregation that has a matching
partnerID. If the partnerID of an existing aggregation is changed
manually, the original member ports will leave. If the partnerID of an
aggregation needs to be configured manually, it should be configured
before any member ports are added. This will ensure that ports gain
the correct partnerID when they are subsequently added to the
aggregation.
Note that LACP enabled ports determine their partnerID automatically
via the LACP protocol.

 How do you make automatic aggregations more resilient to
network failures?

 Unplanned changes in network topology can result in the unexpected
creation of automatic aggregations. For example, if a Distributed Fabric
splits due to failure of its XRN Interconnect, LACP will view the
Distributed Fabric as two separate partnerIDs and automatically create
a second aggregation. To guarantee the new aggregation has a
matching configuration (for example, VLAN membership etc) to the
original aggregation, 3Com recommends that all member ports are
assigned the same configuration before they join the original
aggregation.

 You have an aggregation with a mix of manual and automatic
member ports and some ports are inactive.

 If you mix manual and automatic member ports in the same
aggregation, the aggregation will not always work correctly. Some ports
may become 'inactive' if the Switch is connected to a device that
dynamically varies the aggregation parameters that are exchanged by
LACP. 3Com therefore recommends that aggregations should not be
configured with a mix of automatic and manual member ports.
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Solving SNMP Management Software Problems

 The SNMP Network Management Software cannot access the
Switch.

 Check that:

The IP information for the Switch is correctly configured. 

The Switch was reset after the IP information was defined. 

The IP information for the Switch is correctly recorded by the
Network Management software. For more information, see the
documentation supplied with your Network Management software.

The community strings defined for the Switch are the same as
the ones defined in the Network Management software. 

Remote access to the management software of the Switch is
enabled. 

The port through which you are trying to manage the Switch
belongs to the Default VLAN (VLAN 1). This is the only VLAN that
can be used to access the management software of the Switch.

 Traps are not received by the SNMP Network Management
software.

 Check that the IP information of the SNMP Network Management
software is correctly recorded by the Switch.

 The SNMP Network Management software can no longer access
the Switch.

 Check that:

Remote access to the management software of the Switch has
not been disabled.

The port through which you are trying to access the Switch has
not been disabled. If it is enabled, check the connections and
network cabling for the port. 

The port through which you are trying to manage the Switch has
not been moved from the Default VLAN (VLAN 1). This is the only
VLAN that can be used to access the management software of the
Switch.

If there is still a problem, try accessing the Switch through a different
port. If you can now access the Switch, a problem may have occurred
with the original port. Contact your supplier for further advice.

Related Sections
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Solving Serial Web Utility Problems

 You cannot connect to the web interface of the Switch.

 Check that:

The Switch is powered-up. 

You are using a proper null modem cable. Pin-outs are detailed in
the Getting Started Guide that accompanies your Switch. 

The flow control and line speed (baud rate) settings are the same
on the Switch and on the management workstation.

You have not changed the line speed setting of the management
workstation after the Switch has connected (the Switch only
configures its line speed the first time it connects). 

You have selected the correct serial port on your management
workstation.

You can change some of the settings for the management workstation
using the Advanced Configuration Parameters dialog box. To display
this, select the Serial Web Setup program item in the Serial Web
program group.
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Solving Management Software Upgrade Problems

 How to upgrade the software of your Switch.

 Refer to the instructions for Upgrading Management Software.

 A management software upgrade has failed, and the Power/Self
test LED is flashing on/off green after rebooting.

 Leave the failed Switch powered on for a minimum period of 10
minutes and the Switch will attempt to self recover. If the recovery is
unsuccessful, the Switch reverts to the software version that it was
using before the upgrade began.

 The software version that is running on your Switch is the same
as it was prior to the software upgrade.

 It is possible that your Switch has the Dual Imaging feature. The
software upgrade has failed, so the Switch has automatically reverted
to the initial software version to ensure that it remains operational.

 A management software upgrade has failed, and the PowerOn
Self Test (POST) has failed.
The Power/Self Test LED is yellow.
All of the Port Status LEDs are Off.
You cannot access the Switch via Telnet.

 Refer to the instructions for recovering the Switch from a failed
software upgrade using the Software Update Utility.

 A management software upgrade has failed.

 Take the following steps:

1. Ensure that the unit has: 

Its default IP address (0.0.0.0)

or

A valid IP address that is in the same subnet as the TFTP
server 

2. If the unit has the IP address 0.0.0.0, ensure that it has a valid
IP address that is in the same subnet as the TFTP server. 

3. Attempt the upgrade again.
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Solving Software Update Utility Problems

 An error occurs when the Software Update utility attempts to
connect through the serial port of the PC.

 The serial port being used is not the same as the serial port specified in
the upgrade command. Retry the command ensuring that you specify
the correct serial port.

Also ensure that the serial cable which you are using is a fully wired
cable with handshaking signals. The Software Update utility only works
with this type of serial cable. The cable which you use to manage the
Switch through the terminal may not have handshaking signals and
may therefore not be compatible with the upgrade utility. Refer to the
PC-AT Serial Cable pin-out diagram in Appendix B of the Getting
Started Guide that accompanies your Switch.

 An error occurs when the Software Update utility attempts to
communicate with the Switch.

 There could be a number of reasons for this:

The Switch is not being powered-up within 5 seconds of pressing
Return. 

The null modem cable is not connected to the console port of the
Switch.

The null modem cable is not connected to the serial port of the
PC, or, the serial port being used is not the same as the serial
port specified in the upgrade command. 

The Switch is not being powered-down and up as directed.

Make sure the serial port is not in use by another application,
such as a background hot sync process used by PDAs.

Retry the command ensuring that you follow all the steps.

 An error occurs when the Software Update utility attempts to
open the management software file for reading.

 There could be two reasons for this:

The file specified in the software update command does not exist
or is in a different directory to the one given. Check the filename
and its location. 

You do not have read access for the file. Check the properties of
the file using Explorer (in Windows ’95) or File Manager (in other
versions of Windows).

 An error occurs when the Software Update Utility attempts to
transfer the file.

 There could be a number of reasons for this:

The null modem cable has become disconnected from the Switch
or the PC during the file transfer. Reconnect the cable and start
again.
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Power to the Switch has been disrupted during the file transfer.
Check the power connection to the Switch and start again. 

An incorrect file is being specified and transferred to the Switch.
Check the filenames and start again.

 For more information about solving Software Update Utility problems, see the online
help section contained within the Software Update Utility.
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Solving IP Routing (Layer 3) Problems

 You cannot ping across different VLANs.

 For end stations to ping across different VLANs on the same network,
an IP interface must be assigned to each VLAN.

To do this:

1. Login as admin with no password.

2. At the Top-level menu, enter:

protocol ip interface add

You will then be prompted to enter the following details:

The IP address.

The subnet mask.

The associated VLAN ID.

The type of interface (primary or secondary).

See the protocol ip interface add command for further information.

 The IP address you assign to the IP interface will be the Gateway
address assigned to the end stations connected to that VLAN.

 No RIP updates are being received from other devices.

 Check that all Layer 3 devices on the network, including the Switch, are
configured with the same RIP send and receive modes.

To set the send and receive modes:

1. Check the current RIP settings on the Switch.

2. Change the RIP Receive Mode.

3. Change the RIP Send Mode.

Checking the Current RIP Settings on the Switch

To do this:

1. Login as admin with no password.

2. At the Top-level menu, enter:

protocol ip rip summary

See the protocol ip rip summary command for further information.

Changing the RIP Receive Mode

To do this:
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1. Login as admin with no password.

2. At the Top-level menu, enter:

protocol ip rip receiveMode

You will then be prompted to enter the following details:

The IP interface.

The RIP receive mode.

See the protocol ip rip receiveMode command for further
information.

Changing the RIP Send Mode

To do this:

1. Login as admin with no password.

2. At the Top-level menu, enter:

protocol ip rip sendMode

You will then be prompted to enter the following details:

The IP interface.

The RIP send mode.

See the protocol ip rip sendMode command for further information.

 To ensure the Switch is learning the IP addresses on your network,
check the routing summary information by selecting the
protocol ip route summary command.
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RADIUS Problems

 You have been automatically logged out of the management
interface of the Switch.

 You logged into the management interface of a Switch in the
Distributed Fabric using RADIUS authentication. You will be
automatically logged out of the management interface if a unit is added
to or removed from the Distributed Fabric. You will have to login again
to regain access to the management interface.

 A unit has been added to create a Distributed Fabric and the
configuration of the other unit has been overwritten.

 The Switch that is defined as Unit 1 on the merge will force its
configuration on the other Switch (Unit 2) in the Distributed Fabric.
However, this will NOT happen if Unit 1 has only the default IP
interface, and no other IP interfaces configured, and Unit 2 has IP
interfaces configured in addition to the default interface. In this case,
Unit 2's RADIUS configuration will be forced on the other Switch (Unit
1) in the Distributed Fabric.

 RADIUS is enabled on the Distributed Fabric and you cannot login
to the Web interface.

 If a mixed version Distributed Fabric is being used (some units
supporting RADIUS and some not supporting RADIUS), and RADIUS is
enabled, the Web interface cannot be used to manage the Distributed
Fabric. You must either upgrade all units to the same software version
or disable RADIUS on the Distributed Fabric. The Web interface can be
only used to manage a mixed version Distributed Fabric if RADIUS is
disabled.

 The message "Incorrect password" is displayed, even though the
password entered is correct.

 The message "Incorrect password" may be displayed when an incorrect
password is not the cause of an authentication failure. For example,
during a check-list item failure, "Incorrect password" will be displayed
even though this is not the cause of the authentication failure.

 The shared secret is not being recognised by the Switch or
RADIUS server.

 You must configure the same shared secret value on both the RADIUS
server and the Switch. The minimum supported length on the Switch
for the RADIUS shared secret is 8 characters. The maximum supported
length on the Switch for the RADIUS shared secret is 128 characters.

The maximum supported length for the RADIUS shared secret is
different for each RADIUS server; refer to the documentation that
accompanies your RADIUS server for further information.

The maximum supported length on the Switch for the RADIUS
username and password is 64 characters each.

 The Session History table displays two different login times for
the same username.

 When using the Web interface, the Session History table, accessed by
selecting Security > Device > Authentication > Logins, displays two
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entries for the same login session, each showing different access times.
The first entry shows the time of the initial login and the second entry
shows the time of the latest access.
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Support

  

Problem Solving
 
Solving Other Problems

 You have added the Switch to an already busy network, and
response times and traffic levels have increased.

 You may have added a group of users to one of the Switch ports via a
hub, and not disabled half duplex flow control for the port. Disable half
duplex flow control for all ports that are operating in half duplex and
are connected to multiple devices using a hub.

 You have enabled auto-negotiation for a 10BASE-T/100BASE-TX
port, and you are seeing a large number of late events on the
port.

 The port connected to the Switch is not auto-negotiating and is
operating in full duplex:

If you want the link to operate in full duplex, set the port on the
Switch to operate in full duplex.

If you want the link to operate in half duplex, set the port on the
other end of the link to operate in half duplex. For more
information, see the documentation supplied with the remote
device.

 Slow performance after installing your Switch with an existing
Network adapter.

 Auto-negotiation only works if both sides of the link are set to
negotiate. If an auto-negotiating port is attached to a non auto-
negotiating port, the auto-negotiating port will configure itself to half
duplex. This is to prevent connecting to products that only operate in
half duplex. The default configuration for the Switch ports is auto-
negotiation.

Set the Switch port(s) to 100Mbps, full duplex to match the Network
adapter configuration.

Disable auto-negotiation for the port and then set the port speed and
duplex mode.

Via the CLI:

1. To disable auto-negotiation for the port, refer to the instructions
for Enabling and Disabling Auto-negotiation.

2. To specify the speed and duplex mode of the port, refer to the
instructions for Specifying the Speed and Duplex Mode.

Via the web interface:

To disable auto-negotiation for the port and specify the speed and
duplex mode of the port, refer to the instructions for Enabling and
Disabling Auto-Negotiation.

Related Sections

Web Interface Problems
Solving Command Line Interface Problems
VLAN Problems
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Link Aggregation Problems
SNMP Management Software Problems
Serial Web Utility Problems
Management Software Upgrade Problems
Software Update Utility Problems
Layer 3 Problems
RADIUS Problems
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Serial Web Utility

  

Using the Serial Web Utility
 
This section describes how to access and use the Serial Web Utility.
 
 Introduction to the Serial Web Utility

Installing the Serial Web Utility

Using the Serial Web Utility
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Web Interface

  

Security Device User Modify
 
Changing Your Password

You can change the password for your user using the Modify window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Device -> User -> Modify in the Navigation Tree. 

The Modify window is displayed.

 

The Modify window contains the following elements: 

New Password:
Allows you to enter a new password for your user. The password can be up to 10
characters long and is case-sensitive.

 Passwords must only contain alpha-numeric characters.

Confirm Password:
Allows you to re-enter the new password. The password does not change unless
you enter it in this field.
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Web Interface

  

Physical Interface Ethernet Setup
 
Configuring Ports

You can configure individual and multiple ports on the Switch using the Setup window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Physical Interface -> Ethernet -> Setup in the Navigation Tree;

or

Click the relevant port on the Switch graphic and select Setup.

 If you want to configure several ports at once, you must access the Setup
window through the Navigation Tree. Clicking a port on the Switch graphic will only
allow you to configure that particular port.

If you access the Setup window through the Navigation Tree, you are prompted to
enter the port numbers, port ranges and/or port labels that you wish to configure.

 You must separate the values that you enter with commas.

The Setup window is displayed.

The Setup page contains the following elements:

Port(s):
Displays the number or label of the selected port(s).

Media Type
Displays the media type of the link connected to the port(s).
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Current Port Mode:
Displays the speed and duplex mode of the 1000BASE-SX ports (FD indicates full duplex).

Current Flow Control:
Displays the current flow control setting for the port(s).

Port State: Enabled / Disabled
Allows you to enable or disable the port(s) (that is, turn the port(s) on or off).

Label:
Allows you to assign a name to the port(s).

Port Mode: Auto / 1000FD
This listbox allows you to specify the speed and duplex mode of 1000BASE-SX ports (FD
indicates full duplex).

 CAUTION: To communicate without errors, both ends of a link must use the same
duplex mode.

 Ports operating at 1000 Mbps support full duplex mode only.

Advertised Capabilities: 1000FD / Flow Control
Allows you to select the values that are advertised.

 1000BASE-SX ports support auto-negotiation, however, the standard defines that
1000BASE-SX can only operate at 1000 Mbps, full duplex mode, so they can only auto-
negotiate flow control. 1000BASE-SX ports do not support auto-negotiation of port speed.

 Ports at both ends of the link must be set to auto-negotiate.

HD Flow Control: Enabled / Disabled
Allows you to enable or disable the flow control that can be used when the port is
operating in half duplex. Flow control minimizes packet loss during periods of congestion
on the port.

 The HD Flow Control listbox should be set to disabled if the port is connected to
multiple devices using a hub. If it is enabled, local traffic between those multiple devices
is inhibited. HD Flow Control is not supported by 1000BASE-LX/SX ports.

Default FD Flow Control: Enabled / Disabled / TxOn / RxOn
If auto-negotiation is disabled, this listbox allows you to enable or disable the IEEE
802.3x flow control that can be used when the port is operating in full duplex. If auto-
negotiation is enabled, the listbox displays Auto, and you cannot change the flow control
setting for the port manually. Flow control minimizes packet loss during periods of
congestion on the port.

 rxOn and txOn are unidirectional flow control commands that may be set up for fiber
Gigabit Ethernet ports. If these command options are displayed, 3Com recommends that
they should only be configured by an experienced Network Administrator from the web
interface.

 For IEEE 802.3x flow control to operate correctly, it must be enabled at both ends of
the link.

 If you choose to configure more than one port at the same time, only the values that
are identical for each port are displayed in the Setup window. If a value is different for
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one or more ports, then the field in which it is usually displayed is left blank.

Related Operations

Smart Autosensing Enabling and Disabling Smart Autosensing
Statistics Displaying Unit Statistics
Port Setup Summary Displaying Summary Information for Ports
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Web Interface

  

Physical Interface Ethernet Statistics
 
Displaying Unit Statistics

You can display a range of statistics for all the ports on the Switch using the Statistics window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Physical Interface -> Ethernet -> Statistics in the Navigation Tree;

or

Click the relevant port on the Switch graphic and select Statistics.

 If you want to display the statistics for more than one port at the same time, you must
access the Statistics window through the Navigation Tree. Clicking a port on the Switch
graphic will only allow you to display the statistics for that particular port.

If you access the Statistics window through the Navigation Tree, you are prompted to enter
the port numbers, port ranges and/or port labels that you wish to configure.

 You must separate the values that you enter with commas.

The following window is displayed for a single port.

 

You can click on Differences, Rates, or Utilitizations to change the type of statistics displayed for the
port selected. (Counters is the default screen display.)

Counters
These statistics are the etherstat counters taken from the MIB. The Counters run continually from the
time the unit was last powered up.

Differences
When the Differences statistics option is selected a copy of the etherstats is made and stored. After
each 10 second refresh period the latest etherstat values are read. Therefore the displayed values on
the Differences statistics are the latest values minus the stored values.
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Rates/Sec
The Rates/Sec statistics show two values. The Current figure is the counter rate averaged over the
latest refresh period. The Peak figure is the maximum rate that the counters have reached since the
Statistics window has been open.

Utilizations
The Utilization statistics show network traffic distributions (as percentages of available bandwidth) for
the Switch. The total utilization value displayed will depend upon the ports duplex mode. For half
duplex ports the value will be Rx + Tx. For Full duplex it will be either Rx or Tx, which ever is the
greater.

The following window is displayed for multiple ports.

You can click on Differences to change the type of statistics displayed for the range of ports selected.
(Counters is the default screen display.) 

Related Operations

Setup Configuring Ports
Smart Autosensing Enabling and Disabling Smart Autosensing
Port Setup Summary Displaying Summary Information for Ports
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Web Interface

  

System Unit Name
 
Specifying a Descriptive Name

You can specify a descriptive name for the unit using the Name window.

To access the window:

1. Click Device View on the Toolbar.

2. Select System -> Unit -> Name in the Navigation Tree;

or

Click any grey area on the Switch graphic and select Name.

The Unit Name window is displayed.

 

3. Enter a descriptive name for the unit in the Unit Name field. The name can be up
to 30 characters long.

Related Operations

Notepad Entering Notes About the Unit
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Web Interface

  

System Unit Notepad
 
Entering Notes About the Unit

You can enter notes about the unit using the Notepad window.

To access the window:

1. Click Device View on the Toolbar.

2. Select System -> Unit -> Notepad in the Navigation Tree;

or

Click any grey area on the Switch graphic and select Notepad.

The Notepad window is displayed.

 

The Notepad window allows you to enter up to 512 characters.

3. To save the text that you have entered, click OK.

Related Operations

Name Specifying a Descriptive Name
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Web Interface

  

Physical Interface Ethernet History History-1 Hour
 
Displaying 1-Hour Unit History

You can display the packet activity for all ports on a unit for the previous hour using the History-1
Hour window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Physical Interface -> Ethernet -> History -> History-1 Hour in the Navigation
Tree;

or

Click the device body part on the Switch graphic and select History-1 Hour. 

The History-1 hour window is displayed.

Related Operations

History-48 Hours Displaying 48-Hour Unit History
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Web Interface

  

Physical Interface Ethernet History History-48 Hours
 
Displaying 48-Hour Unit History

You can display the packet activity for all ports on a unit for the previous 48 hours using the
History-48 Hours window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Physical Interface -> Ethernet -> History -> History-48 Hours in the Navigation
Tree;

or

Click the device body part on the Switch graphic and select History-48 Hours. 

The History-48 hours window is displayed.

 

Related Operations

History-1 Hour Displaying 1-Hour Unit History
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Web Interface

  

Physical Interface Ethernet Port Setup Summary
 
Displaying Summary Information for Ports

You can display summary information for all the ports on the Switch using the Port Setup Summary
window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Physical Interface -> Ethernet -> Port Setup Summary in the Navigation Tree;

or

Click the device body part of the Switch graphic and select Port Setup Summary.

The Port Setup Summary window is displayed.

Related Operations

LACP PartnerID Configuring a LACP PartnerID
Setup Configuring Ports
Smart Autosensing Enabling and Disabling Smart Autosensing
Statistics Displaying Unit Statistics
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Web Interface

  

Protocol IP Setup
 
Setting Up IP Information

You can set up the IP information for the Switch using the Setup windows.

To access the windows:

1. Click Device View on the Toolbar.

2. Select Protocol -> IP -> Setup in the Navigation Tree;

or

Click the device body part of the Switch graphic and select Setup. 

The first Setup window is displayed.

3. As you go through the windows, you are asked to enter whether you want to:

- manually configure IP information for the Switch 
- automatically configure IP information for the Switch
- disable the LAN interface

 The Switch has three automatic IP configuration methods that it tries in turn,
these are: DHCP, Auto-IP and BOOTP. For detailed information on how the
automatic IP configuration process works, please refer to the Implementation
Guide that accompanies your Switch.

Automatic is the default setting for IP configuration. If you select Automatic IP
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configuration, no further prompts are displayed.

4. 

If you choose to manually configure the IP information, you are prompted to enter
the following:

IP Address
Allows you to enter a unique IP address for the Switch.

 If you change the IP address of the Switch, you can no longer access the web
interface unless you enter the new IP address in the Location Address field of your
browser. 

Subnet Mask
Allows you to enter a subnet mask for the Switch.

Default Gateway (router)
If your network contains one or more gateways, this field allows you to enter the
IP address of the default gateway.

5. If you select None, no further prompts are displayed.
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Command Line Interface

  

system management password
 
Changing Your Password

You can change the password for the current user using the password command on the
management menu.

 Passwords must only contain alpha-numeric characters and is limited to a maximum
of 10 characters.

To change the password:

1. At the Top-level menu, enter:

system management password

The following prompt appears, allowing you to enter the existing password:

old password:

2. Enter the existing password.

The following prompt is displayed, allowing you to enter a new password for the
current user: 

Enter new password:

3. Enter the new password.

The following prompt is displayed, allowing you to re-enter the new password as
confirmation:

Retype password: 

A message is displayed informing you that the password has been successfully changed.

Related Commands

contact Specifying a Contact Name for the Switch
location Specifying Switch Location Details
name Specifying a Switch Name
remoteAccess Enabling and Disabling Remote Access

 

javascript:history.go(-1)


Command Line Interface - system management remoteAccess

http://support.3com.com/infodeli/tools/switches/4900/dha1770-0aaa06/htmcli/systemmanagementremoteaccess.htm[11/16/2010 9:30:22 AM]

Command Line Interface

  

system management remoteAccess
 
Enabling and Disabling Remote Access

As a basic security measure, you can enable or disable remote access to the
management software of the Switch:

When remote access is enabled, you can access the management software using
all management methods. 

When remote access is disabled: 

Users cannot access the Switch over the network using the command line
interface. 

Users cannot access the Switch over the network using the web interface. 

Users cannot access the Switch using an SNMP Network Manager. 

Users can only access the command line interface or web interface using a
direct connection to the console port of the Switch.

You can enable or disable remote access to the management software of the Switch
using the remoteAccess command on the Management menu.

To enable or disable remote access:

1. At the Top-level menu, enter: 

system management remoteAccess

2. The following prompt is displayed: 

Enter new value (enable,disable) [enable]:

3. Enter enable or disable as required.

Related Commands

contact Specifying a Contact Name for the Switch
location Specifying Switch Location Details
name Specifying a Switch Name
password Changing Your Password
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Command Line Interface

  

security device user modify
 
Modifying User Details

You can modify user details for the Switch using the modify command on the User
menu.

 The user's access level cannot be modified — to change access levels you need to
remove the user and define a new one with the same name.

To modify user details for the Switch:

1. From the Top-level menu, enter:

security device user modify

The following prompt is displayed:

Enter the user name (admin,manager,monitor):

2. Enter the name of the user to be modified.

The following prompt is displayed:

Enter the password:

3. Enter a password for the user.

The following prompt is displayed:

Re-enter the password:

4. Enter the password for the user again.

The following prompt is displayed:

Enter the community string [<user>]:

5. Enter a community string for the user.

Related Commands

create Defining a New User
delete Deleting User Details
pwdRecover Enabling/Disabling Password Recovery
summary Displaying User Details

 

javascript:history.go(-1)


Web Management Interface - System Control Software Upgrade

http://support.3com.com/infodeli/tools/switches/4900/dha1770-0aaa06/htmweb/controlsoftwareupgrade.htm[11/16/2010 9:30:30 AM]

Web Interface

  

System Control Software Upgrade
 
Upgrading Management Software

You can upgrade the management software on the Switch using the Software Upgrade
operation on the Control menu.

Use the method outlined below to upgrade the management software on the Switch,
using the Windows 3Com TFTP Server.

 

Preparing for the Software Upgrade

Before you begin
Preparing the management software file
Setting up your TFTP Server
Configuring the Switch and TFTP Server IP information

 

Performing the Software Upgrade

Performing a TFTP upgrade via the Web Interface
Confirming that your software upgrade has been successful

Before you begin

The 3Com TFTP Server is a Microsoft Windows-only TFTP application. If you are
using another operating system (for example Macintosh or Unix), you will require a
different TFTP Server application, please refer to the instructions that accompanied
your system for further information.

The management software cannot be upgraded out-of-band over RS232 using the
TFTP protocol, because TFTP is not supported over the console port.

The management software cannot be upgraded using IPX, because TFTP/IPX 
(In-band over Ethernet) protocols are not supported.

Upgrading the management software of a Switch results in a reset and causes data
to temporarily stop passing through the Switch. You should perform an upgrade
when your network is inactive, or you should notify users that the network will
temporarily be offline. Users should save their work and exit before the upgrade
begins. 

Ensure that the Switch that you are upgrading and the workstation which is
running the TFTP Server application are on the same IP subnet or have a route
between them. 

Downgrading your Switch to an older version of management software is not
recommended. It may introduce faults that have been fixed in the latest release of
software. 

When the management software is upgraded the Switch will retain all currently
configured settings.

If you are upgrading the software in a mixed Distributed Fabric (that is, one 4900
Family unit and one 40x0Family unit) and you wish the units to reboot
immediately and load the new software image after the upgrade, both software
agent names must be listed at the file name prompt. The software upgrade
process will not swap software images automatically if both units in the Distributed
Fabric are not upgraded successfully. Although the new software image will be in
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Flash, it will be stored as the standby software image.

Preparing the management software file

1. The executable file containing the management software to upgrade the Switch
may be supplied on the CD-ROM that accompanies your Switch. 

3Com recommends that you use the latest version of management software from
the 3Com website:

www.3com.com

2. Run the executable file to extract the .bin file to a tftp boot sub-directory e.g.
C:\Program Files\3Com\TFTP Server\tftpboot. This file contains the management
software.

3. If you have not used the default tftpboot sub-directory, make a note of where you
have extracted the .bin file, as you will need to direct your TFTP Server to it.

Setting up your TFTP Server

 CAUTION: These instructions apply to the 3Com TFTP Server, which is a Microsoft
Windows TFTP application.

1. Install the 3Com TFTP Server:

a. From the CD-ROM that accompanies your Switch, or 

b. By downloading the 3Com TFTP Server (filename 3ts01_xx.exe) from the
3Com website:

http://support.3com.com

2. Install the 3Com TFTP Server on a Microsoft Windows 95/98/NT/2000/XP machine.

3. To launch the 3Com TFTP Server, click Start -> Programs -> 3Com TFTP Server
-> 3Com TFTP Server.

4. Check that the 3Com TFTP Server is configured to point where the .bin upgrade
file is located. To do this:

a. Click the Options button on the 3Com TFTP Server menu bar.

b. The Upload/Download directory file path should point to the tftp boot sub-
directory e.g. C:\Program Files\3Com\TFTP Server\tftpboot. This is the
directory where the Switch will look for the file to upgrade the Switch.

c. You may need to change the path to point to the directory containing the
.bin upgrade file. 

d. Click the OK button to close the Setup window.

 The IP address of the 3Com TFTP Server is displayed on the Title Bar.
You will need this to configure the Switch and TFTP Server with IP
information. 

Configuring the Switch and TFTP Server IP information

1. Ensure that you assign an IP address to the Switch that is being upgraded. For
further information about setting up an IP address, refer to Setting Up IP

http://www.3com.com/
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Information in the Switch documentation.

2. Ensure that you have connected your Switch to the TFTP Server using an RJ45
cable (the TFTP Server is the workstation containing the 3Com TFTP Server
application).

3. The Switch that you are upgrading must:

a. Be in the same subnet as the workstation running your TFTP Server.

For example, if your workstation's IP address is 192.168.1.40, and a subnet
mask of 255.255.255.0, and your Switch unit is configured with an IP
address of 192.168.1.x, and a subnet mask of 255.255.255.0, then your
upgrade should be successful. 

Or, 

b. Have a route between the Switch and the workstation.

 CAUTION: Ensure that the Switch port connected to the TFTP Server belongs to the
Default VLAN (VLAN 1). The TFTP Server can only upgrade the management software of
the Switch if it is connected to the Switch by the Default VLAN or if an IP route exists
between the Default VLAN and the VLAN the TFTP Server belongs to.

Performing a TFTP upgrade via the Web Interface

1. Open your web browser and enter the Switch IP address in the Address or
Location field (press Enter).

2. Log into the Switch. 

The default user name is admin (lower case). There is no default password (press
Enter).

3. Click Device View on the Toolbar. 

4. Select System -> Control -> Software Upgrade in the Navigation Tree. 

5. The Setup window is displayed.
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6. Enter the name of the software upgrade file in the Filename field. The filename
format is:

nnnxx_yy.bin

where nnn is the prefix of Switch and xx_yy is the version of management
software. 

 CAUTION: You must use the nnnxx_yy.bin format, otherwise the upgrade will
fail.

 CAUTION: If you are upgrading the software in a mixed Distributed Fabric
(that is, one 4900 Family unit and one 40x0 Family unit) both software agent
names must be listed at the file name prompt. Enter the software filenames for
both the 4900 and 40x0 software images in the following format example:
s3g4_00.bin gmi4_00.bin

7. Enter the IP address of the TFTP Server in the Server IP Address field. This is the
IP address of the workstation running the TFTP Server application.

 On the 3Com TFTP Server this IP address is displayed on the title bar.

8. You can then specify when you want to use the new software. The choices are:

Immediately after the software is loaded - after the upgrade has completed
the system will automatically reset and be temporarily unavailable while the
new software becomes the active running software. Select this option if you
are upgrading a mixed Distributed Fabric and wish the units to reboot
immediately and load the new software image after the upgrade.
Next time the unit resets - after a successful download of the new software,
the unit will NOT reset, but if the unit resets for any reason thereafter, either
by itself or via user intervention, then the active running software will
become the new software.
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After a swap software command (default) - after a successful download of
the new software, the system will not reset after the download, and the only
way to make this new software the active running software is to issue a
swap software command.

9. Make your selection and click OK.

The following window is displayed:

The unit will report errors if they occur and abort the file transfer if it is unable
to complete it. Follow any instructions listed with the errors to resolve the
problem.

Confirming that your software upgrade has been successful

1. When the software upgrade is complete the following window is displayed (the text
will vary depending on the number of units being upgraded):
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1. Click the OK button to close the Software Upgrade window. If you specified to use
the new software after a swap software command, you will need to go to the Swap
Software web operation. If you specified to use the new software immediately after
the software is loaded, the unit will disconnect the Web session and be unavailable
for both Telnet and Web access for 1—2 minutes while it overwrites the old
software.

 CAUTION: Do not power down or reset the Switch or attempt to stop the
upgrade once it has begun. Interrupting the upgrade will cause the Switch to
become unusable.

2. The Switch will reset when the upgrade is complete, and the Power/Self test LED
will change from flashing ON/OFF Green to solid Green.

Once the LED shows as solid Green the upgrade has been completed and the unit
is again ready for Telnet and Web access.

 If you are unable to access the Switch through the Web Interface or through the
Command Line Interface, then it is possible that you can no longer manage your Switch
due to a failure during the software upgrade. Refer to the Solving Management Software
Upgrade Problems section of the Management Interface Reference Guide for further
assistance.

Related Operations

Initialize Initializing the Switch
Reboot Rebooting the Switch
Swap Software Swap the standby software for the running software.
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Software Update Utility

  

Recovering from a Failed TFTP Software Upgrade
 
This section describes how to recover from a failed TFTP software upgrade.

The CD-ROM supplied with your Switch includes a Software Update Utility that can be
used to update the management software of the Switch. The Utility should only be used
if a previous upgrade has failed, and you are unable to communicate with the Switch
using the web interface or command line interface. You can find the Utility in the
Utility directory on the CD-ROM.

If you have any problems using the Software Update Utility, see Solving Software Update
Utility Problems.

 3Com strongly recommends that you use the TFTP Server as the primary means of
upgrading your Switch. The Software Update Utility should only be used if a TFTP
software upgrade has failed and the Switch has subsequently failed to power up
correctly. The symptoms of a failed TFTP software upgrade are: the PowerOn Self Test
(POST) has failed, the Power/Self Test LED is yellow, all of the Port Status LEDs are Off,
you cannot access the Switch via Telnet.

Related Sections

Using the Software Update Utility
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Command Line Interface

  

protocol ip interface add
 
Adding an IP Interface

You can add a new IP interface by using the add command from the Interface menu. An
IP Interface defines the relationship between an IP VLAN and the subnetworks in the IP
network. Each routing IP VLAN interface is associated with one VLAN that supports IP.
The Switch has one interface defined for each subnet that is directly connected to it.

 A total of 64 IP Interfaces can be defined, one for each subnet in their configuration.

To add a new Interface :

1. At the Top-level menu, enter: 

protocol ip interface add

The following prompt is displayed, allowing you to select an IP address:

Enter IP address:

2. Enter the IP address.

The following prompt is displayed, allowing you to select a subnet mask:

Enter subnet mask:

3. Enter the subnet mask.

The following prompt is displayed, allowing you to select the associated VLAN ID:

Enter associated VLAN ID (1,2,7):

4. Enter the associated VLAN ID.

The following prompt is displayed, allowing you to select the type of IP address:

Enter type of IP address (primary, secondary) [primary]:

5. Enter the type of IP address.

The following message is displayed:

IP Interface number [3] was created.

The displayed fields are:

IP address — the IP address of the interface, chosen from the range of addresses
that the central agency assigned to your organization.
Subnet mask — the 32-bit number that uses the same format and representation
as an IP address. The subnet mask determines which bits in the IP address are
interpreted as the network number, the subnetwork number, and the host number.
VLAN ID — the VLAN index number that is associated with the IP interface.
Type — the type of interface: Primary or Secondary. An interface can have only
one primary IP address but many secondary IP addresses.

Related Commands

remove Removing an IP Interface
modify Modifying IP Interface Information
summary Displaying IP Interface Information
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Command Line Interface

  

protocol ip rip summary
 
Displaying RIP Information

You can display RIP information by using the summary command from the RIP menu.

To display RIP information:

1. At the Top-level menu, enter: 

protocol ip rip summary

The RIP information is displayed as in the following example:

RIP mode is enabled
RIP Update time in seconds: 30 

RIP interface(s) information:

Interface Send
Mode

Receive
Mode

Poison
Reverse

Authentication
Mode

1 RIPv1 RIPv1 disabled none
2 RIPv1Compatible RIPv1or2 enabled password
3 none RIPv1or2 disabled md5

The displayed fields are:

Interface — the IP interface.
Send Mode — the send mode can include the following options: RIPv1,
RIPv1Compatible, RIPv2, none.
Receive Mode — the receive mode can include the following options: RIPv1,
RIPv1orRIPv2, RIPv2, none.
Poison Reverse — whether poison reverse mode is enabled or disabled (by
default, disabled).
Authentication Mode — whether or not a password is used to ensure that
routing information comes from a valid source.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling Poison Reverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip receiveMode
 
Setting the Interface Receive Mode

You can set the RIP receive mode on a selected IP interface by using the receiveMode
command from the RIP menu.

To set the RIP Receive Mode:

1. At the Top-level menu, enter: 

protocol ip rip receiveMode

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (1,3-6,all): 

2. Enter the IP Interface number, or all.

The following prompt is displayed, allowing you to select the receive mode:

Interface [] - Enter RIP receive mode
(none,RIPv1,RIPv2,RIPv1orRIPv2): 

The options are:
none — the Switch broadcasts RIP updates but does not process incoming
RIP packets.
RIPv1 — this configures an interface to accept RIPv1 updates.
RIPv2 — this configures an interface to accept RIPv2 updates.
RIPv1orRIPv2 — this configures an interface to accept both RIPv1 and
RIPv2 updates.

3. Enter the RIP receive mode.

A message detailing the change in RIP receive mode is displayed.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling Poison Reverse
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip sendMode
 
Setting the Interface Send Mode

You can set the RIP send mode on a selected IP interface by using the sendMode
command from the RIP menu. This command configures what the router sends on the
interface.

To set the RIP send mode:

1. At the Top-level menu, enter: 

protocol ip rip sendMode

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (1,3-6,all): 

2. Enter the IP Interface number, or all.

The following prompt is displayed, allowing you to select the send mode:

Interface [] - Enter RIP send mode
(none,RIPv1,RIPv1Compatible,RIPv2):

The options are:
none — the Switch processes all incoming RIP packets, but does not transmit
RIP updates.
RIPv1 — this configures an interface to broadcast RIPv1 updates.
RIPv1Compatible — this configures an interface to broadcast router
information to other routers on the network using the advertisement list for
RIPv2 updates.
RIPv2 — this configures an interface to broadcast RIPv2 updates.

3. Enter the RIP send mode.

A message detailing the change in RIP send mode is displayed.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling Poison Reverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip route summary
 
Displaying Route Summary Information

You can display Route summary information by using the summary command from the
Route menu.

To remove every route:

1. At the Top-level menu, enter: 

protocol ip route summary

The information is displayed as in the following example:

Destination Subnet Mask Metric Gateway Status
Default Route -- -- 158.102.02.123 static
158.220.88.12 255.255.255.0 1 -- local
150.99.21.110 255.255.255.0 1 -- local

The displayed fields are:

Destination — the IP address of the destination network, subnetwork, or host.
This field can also identify a default route which the Switch uses to forward
packets that do not match any other routing table entry.
Subnet mask — the 32-bit number that uses the same format and representation
as an IP address. The subnet mask determines which bits in the IP address are
interpreted as the network number, the subnetwork number, and the host number.
Metric — the measure of the distance, or the number of hops, to the
destination.
Gateway — the address that directs the router to forward packets whose
destination addresses match the route’s IP address and subnet mask. The Switch
forwards such packets to the indicated gateway.
Status — information that the routing protocol has about the route, such as how
the route was put into the routing table.

Related Commands

add Adding a Static Route to the Routing Table
default Defining the Default Route
find Finding an Existing Route in the Routing Table
flush Removing all Learned Routes
noDefault Removing the Default Route
remove Removing an Existing Route
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Web Interface

  

Security Device Authentication Logins
 
Displaying Authentication Login Attempts

You can display the results of the last 16 authentication login attempts for the Switch
using the Logins window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Device -> Authentication -> Logins in the Navigation Tree. 

The Logins window is displayed.

Related Operations

statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
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Summary Displaying RADIUS Summary Information
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Command Line Interface

  

physicalInterface ethernet portMode
 
Specifying the Speed, Duplex, and Autonegotiation Mode

You can specify the speed, duplex, and autonegotiation mode of Ethernet ports on the
Switch using the portMode command on the Ethernet menu.

To specify the speed, duplex, and autonegotiation mode of a port:

1. At the Top-level menu, enter: 

physicalInterface ethernet portMode 

The following prompt is displayed: 

Select Ethernet port (unit:port...,?):

2. Enter the number of the unit and port to have its mode specified.

If the port is a 1000BASE-LX/SX port, the following prompt is displayed: 

Enter new value (1000full)[1000full]:

Other ethernet ports (dependent upon the type of Switch) will display:

Enter auto-negotiation mode (enable,disable)[enable]:

3. Enter enable or disable autonegotiation as required. 

 CAUTION: To communicate without errors, both ends of a link must use the
same duplex mode. 

If you disable autonegotiation, you will be prompted to enter the port mode
settings (that is, the fixed speed/duplex settings) supported by the port(s).

If you select one of the fixed speed/duplex settings, this will be implemented and
no further prompts will be displayed.

4. If you enable autonegotiation, the following example prompt (dependent upon the
type of Switch) is displayed: 

Enter Fallback port mode (10half,10full,100half,100full)[100half]:

You can enter a single line version of this command, which does not require you
waiting for each prompt. For example, from the top level menu at the Select menu
option: prompt, enter: physicalInterface ethernet portMode 1:1 enableAuto
100half

Related Commands

detail Displaying Detailed Information
flowControl Enabling and Disabling Flow Control
portCapabilities Setting the Port Capabilities
portState Enabling and Disabling Ports
smartAutosense Enabling/Disabling Smart Autosensing
summary Displaying Port Summary Information
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Serial Web Utility

  

Using the Serial Web Utility
 
Introduction

If you are using a management workstation running Microsoft Windows® 95/98 and you
want to access the web interface through the console port of your Switch, you must use
the 3Com Serial Web Utility (SLIP driver) on the CD-ROM supplied with the Switch. The
Serial Web Utility can be installed from the Software and Utilities folder.

Every time you want to access the web interface, use the Serial Web Utility to set up the
connection to the web interface; it launches your Web browser and accesses the web
interface using the Serial Line Interface Protocol (SLIP).

If you have any problems accessing the web interface using the Serial Web Utility, see
Solving Serial Web Utility Problems.

Related Sections

Installing the Serial Web Utility
Using the Serial Web Utility
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Serial Web Utility

  

Using the Serial Web Utility
 
Installing the Serial Web Utility

By default, the Serial Web Utility is installed in the following directory:
C:\Program Files\3Com\3Com Serial Web
This can be changed during the installation if required.

To install the Serial Web Utility:

1. Start Windows 95/98.

2. Insert the CD-ROM into your CD-ROM drive. 

3. Double click on the Software and Utilities folder, select the 3Com Serial Web Utility
and click on the install tab.

 If the setup program cannot find specific files on your management
workstation, it asks you to insert your Windows 95/98 CD-ROM. If it still cannot
find the files, you must obtain them directly from Microsoft. Contact Microsoft for
more information.

4. When the installation program has ensured all the relevant files are installed, it
asks you to select a COM port. This is the serial port on your management
workstation that you want to use when connecting to the console port of the
Switch. 

If you click Advanced, the Advanced Configuration Parameters dialog box is
displayed, showing all the settings that the Serial Web Utility uses when it is
running. These default settings are already correct for connection to the Switch, so
you should not need to change them:

Connection name
Allows you to enter a name for the connection. 

Modem name 
Allows you to enter a name for the modem connection. 

PC SLIP Address 
Displays the SLIP address that is to be allocated to the management workstation.
The default address is 192.168.101.2.

Device URL 
Displays the URL that the Serial Web Utility uses to access the Switch, which
includes the SLIP address for the Switch. For example, the default SLIP address for
the Switch is 192.168.101.1 so the URL is:
http://192.168.101.1/

Flow Control None / XON/XOFF / Hardware RTS/CTS 
Allows you to specify the serial line flow control that the management workstation
uses. 

Data bits, Stop bits and Parity are all fixed. 

Speed 1200 / 2400 / 4800 / 9600 / 19200 
Allows you to specify the line speed (baud rate) that the management workstation
uses. 
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You can change the PC SLIP Address, Device URL, Flow Control and Speed settings
after the installation is complete.

5. When you have finished, the final installation dialog box is displayed informing you
that the Serial Web Utility has been installed on your management workstation.
Click Finish to close the dialog box.

6. You are asked if you want to restart Windows so that it can use the new settings
you have configured. You must restart Windows before running the Serial Web
Utility.

When you return to your Windows desktop, the Serial Web Utility shortcut (‘Serial
Web Management’) created by the installation program is displayed. The utility also
has its own program group called Serial Web under the default program group
specified during the install. This contains:

Serial Web Management — Launches the Serial Web Utility.
Serial Web Setup — Displays the Advanced Configuration Parameters dialog
box, which allows you to view and change some of the settings the Serial
Web Utility uses when it is running.
License agreement.

Related Sections

Introduction
Using the Serial Web Utility
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Serial Web Utility

  

Using the Serial Web Utility
 
Using the Serial Web Utility

Every time you want to access the web interface through a serial link, make your
management connection (for more information, see "Setting Up Web Interface
Management" in the Switch Getting Started Guide) and use the Serial Web Utility to set
up your connection:

1. Either:
Double-click on the Serial Web Management shortcut on your Desktop; or
Select the Serial Web Management program item in the Serial Web program
group.

2. The Serial Web Utility opens and asks you if you want to use the URL that has
been set up. The URL includes the SLIP address for the Switch. For example, if the
SLIP address for the Switch is 192.168.101.1, the URL is:
http://192.168.101.1/
If you want to change the URL, click URL. If the URL is correct, click OK. 

3. The Serial Web Utility attempts to establish a connection. 
If successful, the standard Windows Dial-Up Networking dialog box is displayed,
showing the various connection details. Your default Web browser is then launched
with the specified URL. 
The connection is complete if the password panel of the web interface is displayed.
You are now ready to manage the Switch; see Using the Web Interface.

Related Sections

Introduction
Installing the Serial Web Utility
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Web Interface

  

Physical Interface Ethernet Smart Autosensing
 
Enabling and Disabling Smart Autosensing

You can enable and disable smart autosensing for the Switch using the Smart
Autosensing window. If smart autosensing is enabled on a 10BASE-T/100BASE-TX port,
the port can monitor and detect an unacceptably high error rate when autonegotiation
has chosen 100Mbps. If the other end of the link also supports 10/100 autonegotiation,
then this situation is corrected by forcing the link to 10Mbps.

 1000BASE-SX ports do not support this command.

 Smart Autosensing will not operate on links that do not support autonegotiation, or
on links where one end is at a fixed speed.

To access the window:

1. Click Device View on the Toolbar.

2. Select Physical Interface -> Ethernet -> Smart Autosensing in the Navigation
Tree.

The Smart Autosensing window is displayed.

3. From the Smart Autosensing: listbox, select Enabled or Disabled.

Related Operations

Setup Configuring Ports
Statistics Displaying Unit Statistics
Port Setup Summary Displaying Summary Information for Ports
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Web Interface

  

Bridge Link Aggregation Modify Partner ID
 
Setting or Modifying the Partner ID for an Aggregated Link

You can set or modify the identity of a partner unit at the remote end of an aggregated
link on the current Switch unit using the Partner ID window.

This command is used for IEEE Std 802.3-2002 (incorporating 802.3ad) LACP Pre-
Configured Aggregations. This allows you to manually configure a PartnerID (that is, the
MAC address of a partner device) to an aggregated link, so that you know which
aggregated link is associated with which device in your network. On detecting an active
port with a matching PartnerID, LACP will automatically add the port to the pre-
configured aggregated link.

The aggregated link should be manually configured with appropriate configuration
settings, such as VLAN membership, to match the partner device.

To access the Partner ID window:

1. Click Device View on the Toolbar.

2. Select Bridge -> Link Aggregation -> Modify -> Partner ID in the Navigation
Tree.

The Partner ID window is displayed.

The Partner ID window contains the following elements:

Select an Aggregated Link: 
Allows you to select the aggregated link for which you want to set a partner
identity. 

Enter LACP Partner ID:
Allows you to enter the partner identity for the remote end of the aggregated link.
To do this: 

1. From the Link listbox, select an aggregated link.

2. In the LACP Partner ID box enter the 4-digit system priority and the 12-digit
MAC address of the partner unit.
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3. Click OK. The partner ID is assigned to the aggregated link and the Partner
ID window is closed.

Related Operations

AddPort Adding a Port to an Aggregated Link Manually
Admin State Modifying the Administrative State of an Aggregated Link
LACP State Enabling or Disabling Link Aggregation Control Protocol (LACP)
Remove Port Removing a Port from an Aggregated Link Manually
Summary Displaying Summary Information for an Aggregated Link
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Command Line Interface

  

system management contact
 
Specifying a Contact Name for the Switch

You can specify contact name details for the Switch using the contact command on the
management menu.

To specify the administration details:

1. From the Top-level menu, enter:

system management contact

The following prompt is displayed:

Enter system contact [<contact name>]: 

2. Enter a system contact for the Switch. The name can be up to 255 characters long.

Related Commands

location Specifying Switch Location Details
name Specifying a Switch Name
password Changing Your Password
remoteAccess Enabling and Disabling Remote Access
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Command Line Interface

  

system management location
 
Specifying Switch Location Details

You can specify physical location details for the Switch using the location command on
the management menu.

To specify the administration details:

1. From the Top-level menu, enter:

system management location

The following prompt is displayed:

Enter system location [<location>]: 

2. Enter a physical location for the Switch. The location name can be up to 255
characters long.

Related Commands

contact Specifying a Contact Name for the Switch
name Specifying a Switch Name
password Changing Your Password
remoteAccess Enabling and Disabling Remote Access
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Command Line Interface

  

system management name
 
Specifying a Switch Name

You can specify a Switch name using the name command on the management menu.

To specify the administration details:

1. From the Top-level menu, enter:

system management name

The following prompt is displayed:

Enter system name [<system name>]: 

2. Enter a system name for the Switch. The name can be up to 255 characters long.

Related Commands

contact Specifying a Contact Name for the Switch
location Specifying Switch Location Details
password Changing Your Password
remoteAccess Enabling and Disabling Remote Access
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Command Line Interface

  

security device user create
 
Defining a New User

You can define a new user for the Switch using the create command on the user menu.

To define a new user for the Switch:

1. From the Top-level menu, enter:

security device user create

The following prompt is displayed:

Enter a new user name:

2. Enter a name for the new user.

The following prompt is displayed:

Enter the access level (monitor,manager,security) [security]:

3. Enter an access level for the new user.

The following prompt is displayed:

Enter the password:

4. Enter a password for the new user.

The following prompt is displayed:

Re-enter the password:

5. Enter the password for the new user again.

The following prompt is displayed:

Enter the community string [<user>]:

6. Enter a community string for the new user.

Related Commands

delete Deleting User Details
modify Modifying User Details
pwdRecover Enabling/Disabling Password Recovery
summary Displaying User Details
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Command Line Interface

  

security device user delete
 
Deleting User Details

You can delete user details from the Switch using the delete command on the user
menu.

To remove user details from the Switch:

1. From the Top-level menu, enter:

security device user delete

The following prompt is displayed:

Enter the user name (<users>,all):

2. Enter the name of the user that is to have its details removed, or enter all to
remove the details of all users (except default users).

Related Commands

create Defining a New User
modify Modifying User Details
pwdRecover Enabling/Disabling Password Recovery
summary Displaying User Details
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Command Line Interface

  

security device user pwdRecover
 
Enabling/Disabling Password Recovery

You can enable or disable password recovery for the Switch using the pwdRecover
command on the user menu.

 CAUTION: If you disable Password Recovery and subsequently forget the password
for the "admin" user account, you will have to return the Switch to 3Com.

To define a new user for the Switch:

1. From the Top-level menu, enter:

security device user pwdRecover

The following example prompt is displayed:

The Password Recovery feature is enabled.
Enter new value (enable,disable) [enable]:

 For further information about performing password recovery, refer to the section on
Solving Command Line Interface Problems.

Related Commands

create Creating User Details
delete Deleting User Details
modify Modifying User Details
summary Displaying User Details
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Command Line Interface

  

security device user summary
 
Displaying User Details

You can display the user details for the Switch using the display command on the User
menu.

To display the user details for the Switch:

1. From the Top-level menu, enter:

security device user summary

A summary of the user details for the Switch is displayed as shown in the example
below.

User Name Access Level Community String
admin security private
manager manager manager
monitor monitor public

Related Commands

create Defining a New User
delete Deleting User Details
modify Modifying User Details
pwdRecover Enabling/Disabling Password Recovery
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Web Interface

  

System Control Swap Software
 
Swapping the Running Management Software for the Standby Version

Your Switch has two software images of the Gigabit Multilayer Switching (GMS) software
residing in Flash memory. One software image is actively running the system while the
other remains inactive on standby. This is the Dual Flash Images feature.

You can swap the software images that reside in the Flash memory on your Switch using
the Swap Software operation on the Control menu.

 For a detailed description of how the Dual Flash Images feature works please refer to
the Implementation Guide supplied in PDF format on the CD-ROM supplied with your
Switch or on the 3Com Web site.

If, when you carried out a software upgrade you specified that you want to use the new
software after a swap software command is issued (default), this means that after a
successful download of the new software, the system will not reset after the download,
and the only way to make this new standby software the active running software is to
issue a swap software command.

1. Select System -> Control -> Swap Software in the Navigation Tree. 

The Swap Software window is displayed.

2. If you select to run the standby software version, you can specify to reboot
immediately or at a later time as shown in the following window:
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If your Switches are interconnected to create an XRN Distributed Fabric the
following window is displayed.

 CAUTION: All the units in the Distributed Fabric must run the same version of
software. The swap command can only be issued when the standby software for
each unit contains the same version of software as well. If this is not the case,
you are prompted with a window, as shown below:
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3. To carry out the swap software, Click OK. 

4. The unit will disconnect the Web session and be unavailable for both Telnet and
Web access for 1—2 minutes while it overwrites the old software.

 CAUTION: Do not power down or reset the Switch or attempt to stop the
upgrade once it has begun. Interrupting the upgrade will cause the Switch to
become unusable.

5. The Switch will reset when the upgrade is complete, and the Power/Self test LED
will change from flashing ON/OFF Green to solid Green.

Once the LED shows as solid Green the upgrade has been completed and the unit
is again ready for Telnet and Web access.

 If you are unable to access the Switch through the Web Interface or through the
Command Line Interface, then it is possible that you can no longer manage your Switch
due to a failure during the software upgrade. Refer to the Solving Management Software
Upgrade Problems section of the Management Interface Reference Guide for further
assistance.

 

Related Operations

Initialize Initializing the Switch
Reboot Rebooting the Switch
Software Upgrade Upgrade the Switch software.
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Web Interface

  

System Control Initialize
 
Initializing the Switch

You can initialize the Switch by using the Initialize window.

To access the window:

1. Click Device View on the Toolbar.

2. Select System -> Control -> Initialize in the Navigation Tree. 

The following window is displayed.

 

3. To initialize the Switch, select OK.

What Happens During Initialization?

Initializing the Switch returns it to its default (factory) settings. The only information
that does not return to its default setting is the IP and SLIP information, which is
retained to ensure that you can continue managing the Switch. You may want to
initialize the Switch if it has previously been used in a different part of your network, and
its settings are incorrect for the new environment.

 CAUTION: Use great care when initializing the Switch. It removes all configuration
information, including password and security information.

 CAUTION: When initializing the Switch, network loops may occur if you have set up
port trunks, resilient links, VLANs, or the Spanning Tree Protocol. Before initializing the
Switch, ensure you have disconnected the cabling for all standby or duplicate links.

 The Switch takes about 10 seconds to initialize. While the Switch is initializing, you
cannot communicate with it.

Related Operations

Reboot Rebooting the Switch
Software Upgrade Upgrading Management Software
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Web Interface

  

System Control Reboot
 
Rebooting the Switch

You can reboot the Switch by using the Reboot window.

To access the window:

1. Click Device View on the Toolbar.

2. Select System -> Control -> Reboot in the Navigation Tree. 

The following window is displayed.

 

3. To reboot the Switch, click OK.

What Happens During a Reboot?

Rebooting the Switch simulates a power-off/on cycle. You may want to do this if you
need to:

Remove all the learned entries in the Switch Database (SDB).
Reset the statistic counters of the Switch.

 CAUTION: Rebooting the Switch causes some of the traffic being transmitted over
the network to be lost. It also clears all Learned entries from the Switch Database.

 The Switch takes about 10 seconds to reboot. While the Switch is rebooting, you
cannot communicate with it.

Related Operations

Initialize Initializing the Switch
Software Upgrade Upgrading Management Software
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Software Update Utility

  

Using the Software Update Utility
 
Using the Utility

The CD-ROM supplied with your Switch includes a Software Update Utility that can be
used to update the management software of the Switch. This utility must be installed
onto your PC before you can use it. When the Software Update Utility is installed and
run, a series of windows will appear to lead you through the process of updating the
management software.

 Updating a Switch may take up to 20 minutes.

 The Software Update Utility operates on a PC running Windows 95, 98, 2000, NT and
XP.

 Before you attempt to update the software, make sure that you connect the serial
(COM) port of your PC to the console port of the Switch using a null modem cable.

Installing the Software Update Utility

To install the Software Update Utility:

1. Insert the CD-ROM that accompanies your Switch into your CD-ROM drive. After a
moment, the CD-ROM's menu screen will appear.

2. From the menu, select Software and Update Utilities.

3. Double-click the Software Update Utility icon. A Readme file will appear that
contains important information.

4. Carefully read the Readme file, then click Install.

5. Follow the onscreen instructions. After a moment, the Software Update Utility will
be installed onto your PC.

 The name for the Serial Update Utility program is Serial.exe and can be installed
onto your PC to the default address of C:\Program Files\3Com\3Com Software Update
Utility. However, you can change this address if you wish.

Running the Software Update Utility

To run the Software Update Utility, select one of the following from the task bar at the
bottom of your screen:

Start -> Programs -> 3Com Software Update Utility -> 3Com Software
Update Utility.

or

Start -> Run and then enter Serial.exe, which is the name for the Software
Update Utility.

The Software Update Utility's Welcome Screen will then display, allowing you to update
the management software of the Switch.

 The Software Update Utility has its own operating instructions and online help. For
further information on how to update the management software, please refer to the help
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section on the Software Update Utility. 

Related Sections

Introduction
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Command Line Interface

  

protocol ip interface remove
 
Removing an IP Interface

You can remove an existing IP interface by using the remove command from the
Interface menu.

 If you remove an IP interface, any static entry associated with that IP interface will
also be removed.

To remove an existing Interface :

1. At the Top-level menu, enter: 

protocol ip interface remove

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (3-5, all): 

 You cannot delete the default IP interfaces 1 or 2. You can only delete the IP
interfaces that you create. 

2. Enter the IP Interface.

The following prompt is displayed:

IP Interface number [ ] has been removed.

Related Commands

add Adding an IP Interface
modify Modifying IP Interface Information
summary Displaying IP Interface Information
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Command Line Interface

  

protocol ip interface modify
 
Modifying IP Interface Information

You can modify existing IP interface information (interface 1 or 2 only) by using the
modify command from the Interface menu.

 If the default IP interface is modified and the subnet changes, the static routes that
use this IP interface subnet will be deleted. However, if the default IP interface is
modified but remains on the same subnet, the static routes will remain intact.
Furthermore, if the default IP interface is modified and the new address is identical to a
static route address or a static route gateway, the static route is removed.

To modify an existing Interface :

1. At the Top-level menu, enter: 

protocol ip interface modify

The following prompt is displayed, allowing you to select an IP interface:

WARNING: Changing IP configuration may disrupt device operation
temporarily, or cause loss of communication with the unit. 

Enter IP interface (1-2): 

2. Enter the IP Interface.

The following prompt is displayed, allowing you to select the configuration method:

Enter configuration method (auto,manual,none) [auto]: 

3. Enter the configuration method.

The following prompt is displayed, allowing you to select the IP address:

Enter IP address:

4. Enter the IP address.

The following prompt is displayed, allowing you to select a subnet mask:

Enter subnet mask:

5. Enter the subnet mask.

The following prompt is displayed, allowing you to select the associated VLAN ID:

Enter associated VLAN ID (1) [1]:

6. Enter the associated VLAN ID.

The following prompt is displayed:

Interface 1 - has been modified.

Related Commands

add Adding an IP Interface
remove Removing an IP Interface
summary Displaying IP Interface Information
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Command Line Interface

  

protocol ip interface summary
 
Displaying IP Interface Summary Information

You can display summary information for an existing IP interface by using the summary
command from the Interface menu.

To display IP Interface summary information:

1. At the Top-level menu, enter: 

protocol ip interface summary

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (1-6, all): 

2. Enter the IP Interface number, or all.

The IP Interface summary information is displayed as in the following example:

The IP address for interface 1 has been configured manually.

Index Type IP Address Subnet mask State VLAN ID
1 Primary 161.44.20.20 255.255.255.0 Up 1
2 SLIP 161.42.33.45 255.255.255.0 Up n/a
3 Primary 161.63.32.02 255.255.255.0 Up 7
4 Secondary 161.21.14.37 255.255.255.0 Up 7

The displayed fields are:

Index — the index number of the IP interface whose summary information you
want to display.
Type — the type of interface: Primary or Secondary. An interface can have only
one primary IP address but many secondary IP addresses.
IP address — the IP address of the interface, chosen from the range of addresses
that the central agency assigned to your organization.
Subnet mask — the 32-bit number that uses the same format and representation
as an IP address. The subnet mask determines which bits in the IP address are
interpreted as the network number, the subnetwork number, and the host number.
State — the state of the IP interface. It indicates whether the interface is
available for communications (Up) or unavailable (Down).
VLAN ID — the VLAN index number that is associated with the IP interface.

Related Commands

add Adding an IP Interface
modify Modifying IP Interface Information
remove Removing an IP Interface
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Command Line Interface

  

protocol ip rip authentication
 
Setting the Authentication Password and Mode

You can set the Authentication Password and Mode for an existing IP interface by using
the authentication command from the RIP menu. This command determines whether
or not a password is used to ensure that routing information arrives from a valid source.

 If the sending interface has an IP RIP-2 password, the receiving interface must have
the same IP RIP-2 password. If the receiving interface has a different password or a null
password, its routing table is not updated.

 If you are using RIP-1, do not use the password option.

To set the Authentication password and mode:

1. At the Top-level menu, enter: 

protocol ip rip authentication

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (1,3-6,all): 

2. Enter the IP Interface.

The following prompt is displayed, allowing you to select the RIP authentication
mode:

Interface [ ] - Enter RIP authentication mode
(none,password,md5) [none]: 

The options are:
none — deactivates authentication on the specified interface.
password — sets authentication into a simple password mode on a specified
interface.
md5 — sets authentication into md5 mode on a specified interface.

3. Enter the RIP authentication mode.

The following prompt is displayed, allowing you to select the RIP authentication
key:

Enter RIP authentication key (up to 16 char.): 

4. Enter the RIP authentication key. 

The following prompt is displayed, allowing you to re-enter the RIP authentication
key:

Re-enter key: 

5. Reenter the authentication key.

 The RIP authentication key is used both for password coding and md5 coding.

Related Commands

mode Enabling or Disabling the RIP Mode
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neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling poisonReverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip mode
 
Enabling or Disabling the RIP Mode

You can disable or enable RIP operation on all IP interfaces by using the mode command
from the RIP menu.

To enable or disable the RIP operation:

1. At the Top-level menu, enter: 

protocol ip rip mode

The following prompt is displayed, allowing you to select the RIP mode:

Enter RIP mode (disabled,enabled)[disabled]: 

The options are:

enabled — The Switch broadcasts RIP updates and processes incoming RIP
packets.
disabled — the Switch ignores all incoming RIP packets and does not
generate any packets of its own.

2. Enter the RIP mode.

A message detailing the change in RIP mode is displayed.

Related Commands

authentication Setting Authentication Passwords and Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling poisonReverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip neighbors
 
Displaying Neighbor Information

You can display general information about well-known neighboring routers, along with
key statistics on each neighbor, by using the neighbors command from the RIP menu.

To display neighbor information:

1. At the Top-level menu, enter: 

protocol ip rip neighbors

The neighbor information is displayed as in the following example:

Peer Mode Time since Update Bad Packets Bad Routes
158.101.63.5 RIPv1 20 seconds ago 0 1

The displayed fields are:

Peer — IP address of a neighboring RIP router.
Mode — whether RIPv1 or RIPv2 packets were received from the specified
neighbor.
Time Since Update — the last time that a route update was received from the
specified neighbor.
Bad Packets — the number of bad RIP packets received from the specified
neighbor.
Bad Routes — the number of bad routes received from the specified neighbor.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
poisonReverse Enabling or Disabling poisonReverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip poisonReverse
 
Enabling or Disabling Poison Reverse

You can enable or disable poison reverse by using the poisonReverse command from
the RIP menu.

 When you enable Poison Reverse, the Switch advertises reverse routes in updates,
but sets the metrics to 16 (infinity). Setting the metric to infinity breaks the loop
immediately when two routers have routes that point to each other.

 When you disable Poison Reverse, reverse routes are not advertised.

To enable or disable poison reverse:

1. At the Top-level menu, enter: 

protocol ip rip poisonReverse

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (1,3-6,all): 

2. Enter the IP Interface number, or all.

The following prompt is displayed, allowing you to select the poison reverse mode:

Interface [] - Enter RIP poison reverse mode
(enabled,disabled): 

3. Enter enabled or disabled.

A message detailing the change in poison reverse is displayed.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip resetStats
 
Resetting the RIP Statistics

You can reset the RIP statistics by using the resetStats command from the RIP menu.

To reset the RIP statistics:

1. At the Top-level menu, enter: 

protocol ip rip resetStats

The following message is displayed:

The RIP statistics have been reset.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling Poison Reverse
receiveMode Setting the Interface Receive Mode
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip statistics
 
Displaying RIP Interface Statistics

You can display RIP statistics for an interface by using the statistics command from
the RIP menu.

To display RIP interface Statistics:

1. At the Top-level menu, enter: 

protocol ip rip statistics

The following prompt is displayed, allowing you to select an IP interface:

Enter IP interface (1,3-6,all): 

2. Enter the IP Interface number, or all.

The RIP interface statistics are displayed as in the following example:

Interface Received Bad Packets Received Bad Routes Sent Updates
1 2 1 10789

The displayed fields are:

Interface — the desired IP interface.
Received Bad Packets — the number of bad RIP packets received.
Received Bad Routes — the number of bad routes received.
Sent Updates — the number of route changes.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling Poison Reverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
summary Displaying RIP Information
updateTime Setting the RIP Update Time
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Command Line Interface

  

protocol ip rip updateTime
 
Setting the RIP Update Time

You can set the RIP update time by using the updateTime command from the RIP menu.
The RIP update time is the interval at which this Switch will advertise route information.

To set the RIP update time:

1. At the Top-level menu, enter: 

protocol ip rip updateTime

The following prompt is displayed, allowing you to select the update time:

Enter RIP update time in seconds (15-60)[30]: 

2. Enter the RIP update time.

A message detailing the change in RIP update time is displayed.

Related Commands

authentication Setting Authentication Passwords and Mode
mode Enabling or Disabling the RIP Mode
neighbors Displaying Neighbor Information
poisonReverse Enabling or Disabling Poison Reverse
receiveMode Setting the Interface Receive Mode
resetStats Resetting the RIP Statistics
sendMode Setting the Interface Send Mode
statistics Displaying the RIP Statistics
summary Displaying RIP Information

 

javascript:history.go(-1)


Command Line Interface - protocol ip route add

http://support.3com.com/infodeli/tools/switches/4900/dha1770-0aaa06/htmcli/protocoliprouteadd.htm[11/16/2010 9:32:35 AM]

Command Line Interface

  

protocol ip route add
 
Adding a Static Route

You can add a static route to a routing table by using the add command from the Route
menu. A static route is useful in environments where no routing protocol is used or
where you want to overide some of the routes that are generated with a routing
protocol.

 Static routes take precedence over dynamically learned routes to the same
destination.

 Static routes are included in periodic Routing Information Protocol (RIP) updates that
the Switch sends.

To add a static route:

1. At the Top-level menu, enter: 

protocol ip route add

The following prompt is displayed, allowing you to select the destination IP
address:

Enter destination IP address:

2. Enter the destination IP address.

The following prompt is displayed, allowing you to select a subnet mask:

Enter subnet mask: 

3. Enter the subnet mask.

The following prompt is displayed, allowing you to select the gateway IP address:

Enter gateway IP address: 

4. Enter the gateway IP address.

The following prompt is displayed, allowing you to select the route metric:

Enter route metric (1-16): 

5. Enter the route metric.

The following message is displayed:

The specified route has been added.

The displayed fields are:

Destination IP address — the IP address of the destination network,
subnetwork, or host. This field can also identify a default route which the Switch
uses to forward packets that do not match any other routing table entry.
Subnet mask — the 32-bit number that uses the same format and representation
as an IP address. The subnet mask determines which bits in the IP address are
interpreted as the network number, the subnetwork number, and the host number.
Gateway — the address that directs the router to forward packets whose
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destination addresses match the route’s IP address and subnet mask. The Switch
forwards such packets to the indicated gateway.
Metric — the measure of the distance, or the number of hops, to the
destination.

Related Commands

default Defining the Default Route
find Finding an Existing Route in the Routing Table
flush Removing all Learned Routes
noDefault Removing the Default Route
remove Removing an Existing Route
summary Displaying Summary Information for the Default Route
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Command Line Interface

  

protocol ip route default
 
Defining the Default Route

You can define the default route by using the default command from the Route menu.
The router uses the default route to forward packets that do not match any other
routing entry. The Switch can learn a route through the routing protocol, or you can
statically configure a default route.

 If the routing table does not contain a default route, the Switch cannot forward a
packet that does not match any other routing table entry. When the Switch drops the
packet, it sends an Internet Control Message Protocol (ICMP) destination unreachable
message to the host that sent the packet.

To configure the default route:

1. At the Top-level menu, enter: 

protocol ip route default

The following prompt is displayed, allowing you to enter a default gateway IP
address for the Switch:

Enter gateway IP address: 

2. Enter the gateway IP address.

3. Enter a valid IP address, if required.

Related Commands

add Adding a Static Route to the Routing Table
find Finding an Existing Route in the Routing Table
flush Removing all Learned Routes
noDefault Removing the Default Route
remove Removing an Existing Route
summary Displaying Summary Information for the Default Route
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Command Line Interface

  

protocol ip route find
 
Finding an Existing Route

You can find an existing route in the routing table by using the find command from the
Route menu.

To find an existing route:

1. At the Top-level menu, enter: 

protocol ip route find

The following prompt is displayed, allowing you to select the IP address:

Enter IP address: 

2. Enter the IP address.

The following prompt is displayed, allowing you to select the subnet mask:

Enter subnet mask:

3. Enter the subnet mask.

The route is displayed as in the following example:

Destination Mac Address Metric Gateway Status
158.101.62.0 255.255.255.0 5 158.101.60.22 Learned

The displayed fields are:

Destination IP address — the destination network, subnetwork or host.
Mac address — the address of a device on the network.
Metric — a measure of the distance, or the number of hops, to the destination.
Gateway IP address — the IP address of the router interface through which the
packet travels on its next hop.
Status — information that the routing protocol has about the route, such as how
the route was put into the routing table.

Related Commands

add Adding a Static Route to the Routing Table
default Defining the Default Route
flush Removing all Learned Routes
noDefault Removing the Default Route
remove Removing an Existing Route
summary Displaying Summary Information for the Default Route
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Command Line Interface

  

protocol ip route flush
 
Removing Every Route

You can remove every route from a routing table by using the flush command from the
Route menu.

 Flushing the routing table does not cause the Routing Information Protocol (RIP) to
update the routing table. You must change the metric to update the routing table.

To remove every route:

1. At the Top-level menu, enter: 

protocol ip route flush

The following prompt is displayed, allowing you to delete all routes from the
routing table:

This operation will delete all routes from the Routing Table.
Do you wish to continue (yes,no)[no]:

2. Enter yes or no.

If you enter yes, the following message is displayed:

The Routing Table has been flushed.

Related Commands

add Adding a Static Route to the Routing Table
default Defining the Default Route
find Finding an Existing Route in the Routing Table
noDefault Removing the Default Route
remove Removing an Existing Route
summary Displaying Summary Information for the Default Route
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Command Line Interface

  

protocol ip route noDefault
 
Removing the Default Route

You can remove the default route by using the noDefault command from the Route
menu.

 The Switch deletes the default route from the routing table immediately after you
enter the command. You are not prompted to confirm the deletion.

To remove the default route:

1. At the Top-level menu, enter: 

protocol ip route noDefault

The following prompt is displayed if there is no default route configured:

No items to remove.

Related Commands

add Adding a Static Route to the Routing Table
default Defining the Default Route
find Finding an Existing Route in the Routing Table
flush Removing all Learned Routes
remove Removing an Existing Route
summary Displaying Summary Information for the Default Route
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Command Line Interface

  

protocol ip route remove
 
Removing an Existing Route

You can remove an existing route from a routing table by using the remove command
from the Route menu.

 When you enter the command, the Switch deletes the route immediately from the
routing table. You are not prompted to confirm the deletion.

To remove an existing route:

1. At the Top-level menu, enter: 

protocol ip route remove

The following prompt is displayed, allowing you to select the destination IP
address:

Enter destination IP address:

2. Enter the destination IP address.

The following prompt is displayed, allowing you to select a subnet mask:

Enter subnet mask: 

3. Enter the subnet mask.

The following message is displayed:

The specified route has been removed. 

Related Commands

add Adding a Static Route to the Routing Table
default Defining the Default Route
find Finding an Existing Route in the Routing Table
flush Removing all Learned Routes
noDefault Removing the Default Route
summary Displaying Summary Information for the Default Route
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Web Interface

  

Security Device Authentication Statistics
 
Displaying Authentication Statistics

You can display the results of login attempts to the Switch using the Statistics window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Device -> Authentication -> Statistics in the Navigation
Tree. 

The Statistics window is displayed.

Related Operations

logins Displaying Authentication Login Attempts
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
Summary Displaying RADIUS Summary Information

 

javascript:history.go(-1)


Web Management Interface - Security Device Authentication Summary

http://support.3com.com/infodeli/tools/switches/4900/dha1770-0aaa06/htmweb/deviceauthenticationsummary.htm[11/16/2010 9:32:58 AM]

Web Interface

  

Security Device Authentication Summary
 
Displaying the Current Setting of the Device Authentication Mode

You can display the current setting of the device authentication mode for the Switch
using the using the Summary window. This window will also display the RADIUS client
settings, if applicable.

To access the Summary window:

1. Click Device View on the Toolbar.

2. Select Security -> Device -> Authentication -> Summary in the Navigation
Tree. 

The Summary window is displayed.

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
Summary Displaying RADIUS Summary Information
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Web Interface

  

Security Device Authentication SystemMode
 
Modifying the Authentication Mode

You can select either the local database or the RADIUS server to be used when
authenticating device login requests for the Switch using the SystemMode window.

To access the SystemMode window:

1. Click Device View on the Toolbar.

2. Select Security -> Device -> Authentication -> SystemMode in the Navigation
Tree. 

The SystemMode window is displayed.

3. Select the excluded IP address that you wish to modify and then select Local or
RADIUS from the Device Authentication Mode pull down menu.

4. Click OK. The authentication mode is changed to the selected state, and the
SystemMode window closes.

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
Summary Displaying RADIUS Summary Information
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Web Interface

  

Security Radius Authentication Display
 
Displaying the RADIUS Authentication Statistics for the Switch

You can display the RADIUS authentication statistics for the Switch using the Display
window.

These statistics can be used for monitoring and troubleshooting your system.

To access the Display window:

1. Click Device View on the Toolbar.

2. Select Security -> Radius -> Authentication -> Display in the Navigation Tree.

A summary of the RADIUS authentication statistics for the Switch is displayed as
shown in the example below.

The window contains the following elements: 

Primary:
This column displays the statistics associated with the primary RADIUS server, if
configured.

Secondary:
This column displays the statistics associated with the secondary RADIUS server, if
configured.

Total:
This column displays the statistics associated with both RADIUS servers, if
configured.

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
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Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
Summary Displaying RADIUS Summary Information
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Web Interface

  

Security Radius Authentication Modify
 
Modifying the RADIUS Authentication Configuration

You can modify the RADIUS authentication configuration for the Switch using the Modify
window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Radius -> Authentication -> Modify in the Navigation Tree. 

The Modify window is displayed.

 

3. Enter the IP address of the RADIUS servers that you wish to be the Primary and
Secondary Authentication Servers.

4. Enter the UDP port number of the RADIUS servers that you wish to be the Primary
and Secondary Authentication Servers.

5. Click OK. The authentication server information is changed to that specified, and
the Modify window closes.

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
Summary Displaying RADIUS Summary Information
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Web Interface

  

Security Radius Retries
 
Modifying the RADIUS Retry Parameters

You can modify the RADIUS retry parameters for all RADIUS servers on your network
using the Retries window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Radius -> Retries in the Navigation Tree. 

The Retries window is displayed.

 

3. Enter the maximum number of login attempts that you wish your Switch to make
to the RADIUS authentication server, and the timeout period in seconds that you
wish your Switch to wait before making a further login attempt.

4. Click OK. The RADIUS retry information is changed to that specified, and the
Retries window closes.

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
SharedSecret Modifying RADIUS Security Key
Summary Displaying RADIUS Summary Information
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Web Interface

  

Security Radius SharedSecret
 
Modifying the Security Key

You can modify the security key, that is the shared secret value that the Switch and the
RADIUS server use, using the SharedSecret window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Radius -> SharedSecret in the Navigation Tree. 

The SharedSecret window is displayed.

 

3. Enter the Shared Secret that you wish the Switch and the RADIUS server(s) to
use.

 The shared secret on the Switch must exactly match the shared secret on the
RADIUS server. And this shared secret must not exceed 128 characters, even if the
server supports a greater number of characters.

4. Click OK. The Shared Secret information is changed to that specified, and the
Shared Secret window closes. 

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
Summary Displaying RADIUS Summary Information
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Web Interface

  

Security Radius Summary
 
Displaying the RADIUS Configuration Settings of the Switch

You can display a summary of the RADIUS configuration settings of the Switch using the
Summary window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Security -> Radius -> Summary in the Navigation Tree. 

The Summary window is displayed as shown in the example below.

Related Operations

logins Displaying Authentication Login Attempts
statistics Displaying Authentication Statistics
summary Displaying Authentication Summary Information
systemMode Modifying Authentication Mode
Authentication Display Displaying RADIUS Authentication Statistics
Authentication Modify Modifying the RADIUS Authentication Configuration
Retries Modifying the RADIUS Retry Parameters
SharedSecret Modifying RADIUS Security Key
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Command Line Interface

  

physicalInterface ethernet detail
 
Displaying Detailed Information

You can display detailed information and statistics about a single Ethernet port using the
detail command on the ethernet menu.

The values are automatically refreshed and updated every 10 seconds. The detail screen can
be changed from the default Counters display to either Differences, Rates, or Utilization,
as detailed in step 3.

To display the information:

1. At the Top-level menu, enter:

physicalInterface ethernet detail

The following prompt is displayed:

Select Ethernet port (unit:port,?):

2. Enter the unit and Ethernet port number you wish to learn more about.

An example of the information displayed is shown below:

Port: 1:2 State: enabled Mode: 1000full (Auto)
Media Type: 10BASE-T/100BASE-TX/1000BASE-T  
Active Features: STAP Enabled, BSC Enabled

Refresh Time: xx Seconds   
    
-Counters-  -Rx- -Tx-
Unicast Packets:  1234567890 21068955
Non Unicast Packets:  60175 3293577
Octets:  42222265 1649693060
Fragments (Rx)/Collisions (Tx): 0 0
Discarded Packets:  0 -
    
-Rx Errors-    
Undersize: 0 Oversize: 0
CRC Error: 0 Jabbers: 0
    
-Pkt Analysis-   

64 Octets: 22285440 256 to 511 Octets: 11927

65 to 127 Octets: 1872859 512 to 1023 Octets: 431
128 to 255 Octets: 191798 1024 to 1518 Octets: 77
    
Quit Counters Differences Rates Utilization

3. Enter Q to quit and return to the previous menu. Or you can enter C: to display the
Counter values for all the fields, D: to display the differences, R: to display the rates, or
U: to display the utilization as a percentage for the port.

You can click on Differences, Rates, or Utilitizations to change the type of statistics displayed for
the port selected. (Counters is the default screen display.)

Counters
These statistics are the etherstat counters taken from the MIB. The Counters run continually from
the time the unit was last powered up. 

Differences
When the Differences statistics option is selected a copy of the etherstats is made and stored.
After each 10 second refresh period the latest etherstat values are read. Therefore the displayed
values on the Differences statistics are the latest values minus the stored values.
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Rates/Sec
The Rates/Sec statistics show two values. The Current figure is the counter rate
averaged over the latest refresh period. The Peak figure is the maximum rate that the
counters have reached since the Statistics window has been open.

Utilizations
The Utilization statistics show network traffic distributions (as percentages of available bandwidth)
for the Switch. The total utilization value displayed will depend upon the ports duplex
mode. For half duplex ports the value will be Rx + Tx. For Full duplex it will be either Rx
or Tx, which ever is the greater.

Related Commands

flowControl Enabling and Disabling Flow Control
portCapabilities Setting the Port Capabilities
portMode Specifying Speed, Duplex and Autonegotiation Mode
portState Enabling and Disabling Ports
smartAutosense Enabling/Disabling Smart Autosensing
summary Displaying Port Summary Information
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Command Line Interface

  

physicalInterface ethernet flowControl
 
Enabling and Disabling Flow Control

IEEE 802.3x flow control minimizes packet loss during periods of congestion on ports
that are operating in full duplex.

You can enable or disable IEEE 802.3x flow control for Ethernet ports on the Switch
using the flowControl command on the Ethernet menu.

If autonegotiation is disabled, then the flowControl command specifies the flow control
of the port. If autonegotiation is enabled, the flowControl value you specify is used as
the default value when autonegotiation is disabled or fails.Therefore, if autonegotiation is
enabled, the flowControl command does not show the current flow control of the port.

 During auto-negotiation flow control is determined by the advertised pause bits of
the ports at both ends of the link. The advertised pause bits may be set or cleared using
the flowControl parameter in the portCapabilities command.

To enable or disable IEEE 802.3x flow control for a port:

1. At the Top-level menu, enter: 

physicalInterface ethernet flowControl 

The following prompt is displayed: 

Select Ethernet port (unit:port...,all,?):

2. Enter the number of the port to have IEEE 802.3x flow control enabled or
disabled, or enter all for all the ports. 

The following prompt is displayed: 

Enter new value (on,off) [on]: 

3. Enter on or off. 

If you are enabling or disabling IEEE 802.3x flow control for all the ports, only the
ports which can support IEEE 802.3x flow control are changed.

 rxOn and txOn are unidirectional flow control commands that may be set up for fiber
Gigabit Ethernet ports. If these command options are displayed, 3Com recommends that
they should only be configured by an experienced Network Administrator from the web
interface.

 For IEEE 802.3x flow control to operate correctly, it must be enabled at both ends of
the link.

Related Commands

detail Displaying Detailed Information
portCapabilities Setting the Port Capabilities
portMode Specifying Speed, Duplex and Autonegotiation Mode
portState Enabling and Disabling Ports
smartAutosense Enabling/Disabling Smart Autosensing
summary Displaying Port Summary Information
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Command Line Interface

  

physicalInterface ethernet portCapabilities
 
Setting the Port Capabilities

You can modify the port capabilities that are advertised when your switch has
autonegotiation enabled using the portCapabilities command on the ethernet menu.

This command gives you greater control over autonegotiation. For example, you may
want to restrict the bandwidth of certain ports (whilst allowing autonegotiation of duplex
mode), or to restrict autonegotiation where there are compatibility issues.

To set the port capabilities:

1. At the Top-level menu, enter:

physicalInterface ethernet portCapabilities

The following prompt is displayed:

select Ethernet port (unit:port,?):

2. Enter the number of the port to be modified.

The following prompt is displayed:

Enter new advertised capabilities - comma separated or all
(10half,10full,100half,100full,1000full,flowcontrol,all)
[10half,10full,100half,100full,1000full,flowcontrol]:

 The advertised port capabilities will vary depending on your type of Switch
unit. 

3. Enter, for example, 1000full, or all.

Related Commands

detail Displaying Detailed Information
flowControl Enabling and Disabling Flow Control
portMode Specifying Speed, Duplex and Autonegotiation Mode
portState Enabling and Disabling Ports
smartAutosense Enabling/Disabling Smart Autosensing
summary Displaying Port Summary Information
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Command Line Interface

  

physicalInterface ethernet portState
 
Enabling and Disabling Ports

You can enable and disable Ethernet ports on the Switch using the portState command
on the Ethernet menu.

 By default, all ports on the Switch are enabled.

To enable or disable a port:

1. At the Top-level menu, enter: 

physicalInterface ethernet portState

The following prompt is displayed: 

Select Ethernet port (unit:port...,?):

2. Enter the number of the port to be enabled or disabled. 

The following prompt is displayed:

Enter new value (enable, disable) [enable]: 

3. Enter enable or disable.

Related Commands

detail Displaying Detailed Information
flowControl Enabling and Disabling Flow Control
portCapabilities Setting the Port Capabilities
portMode Specifying Speed, Duplex and Autonegotiation Mode
smartAutosense Enabling/Disabling Smart Autosensing
summary Displaying Port Summary Information
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Command Line Interface

  

physicalInterface ethernet smartAutosense
 
Enabling/Disabling Smart Autosensing

Smart autosensing allows autonegotiating multi-speed ports, such as 10/100 Mbps or
100/1000 Mbps, to monitor and detect errors in the “physical” interconnection to another
port and react accordingly. For example, smart autosensing can detect network
problems, such as an unacceptably high error rate (set in a pre-defined threshold), or a
1000 Mbps link that fails to establish, or a poor quality cable. If both ends of the link
support 100/1000 Mbps autonegotiation, where one end is connected to a 100 Mbps port
and the other is connected to a 1000 Mbps port, then autosensing tunes the link to 100
Mbps to provide you with an error-free 100 Mbps connection to the network.

An SNMP Trap can be sent every time a port is down-rated to a lower speed.

 1000BASE-SX ports do not support this command.

 Smart Autosense will not operate on links that do not support autonegotiation, or on
links where one end is at a fixed speed.

You can enable or disable smart autosense on the Switch using the smartAutosense
command on the Ethernet menu.

To enable or disable the smart autosensing:

1. At the Top-level menu, enter:

physicalInterface ethernet smartAutosense

The following prompt is displayed:

Enter new value (enable, disable) [enable]:

2. Enter enable or disable.

Related Commands

detail Displaying Detailed Information
flowControl Enabling and Disabling Flow Control
portCapabilities Setting the Port Capabilities
portMode Specifying Speed, Duplex and Autonegotiation Mode
portState Enabling and Disabling Ports
summary Displaying Port Summary Information
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Displaying Port Summary Information

You can display summary information about Ethernet ports on the Switch using the summary
command on the Ethernet menu.

The values are automatically refreshed and updated every 10 seconds and the values displayed
are taken over a sampling time of 10 seconds. The summary screen can be changed from the
default Counters display to Differences as detailed in step 3.

The display is refreshed and updated every 10 seconds

To display the port summary information:

1. At the Top-level menu, enter: 

physicalInterface ethernet summary 

The following prompt is displayed:

Select Ethernet port (unit:port...,all,?):

2. Enter the unit and port number, or enter all for all the ports. 

The port summary information for the port(s) is displayed.

An example of the port summary information is shown below:

Refresh Time: 10 Seconds Sampling Time: 10 Seconds  
       
Port  State Mode Rx Packets Rx Octets Errors
--------------------------------------------------------------------------
1:1  enabled 1000full (Auto) 163542 65439864 4
1:2  disabled 0 0 0 0
1:3  enabled 1000full (Auto) 639263 83636219 4
...       
1:24  enabled 1000full (Auto) 645232 23142514 0
2:1  enabled 1000full (Auto) 163542 65439864 3
2:2  enabled 1000full (Auto) 163542 65439864 3
2:3  enabled 1000full (Auto) 163542 65439864 3
...       
2:24  enabled 1000full (Auto) 163542 83636219 0
       
Quit  Counters Differences Previous Next  
       

3. Enter Q to quit and return to the previous menu. Or you can enter Counters to display
the Counter values for the ports (default display), or Differences to display the
differences. Enter Next or Previous to scroll a page at a time up and down through the
selected ports.

Counters
These statistics are the etherstat counters taken from the MIB. The Counters run continually from
the time the unit was last powered up.

Differences
When the Differences statistics option is selected a copy of the etherstats is made and stored.
After each 10 second refresh period the latest etherstat values are read. Therefore the displayed
values on the Differences statistics are the latest values minus the stored values.

Related Commands

detail Displaying Detailed Information
flowControl Enabling and Disabling Flow Control
portCapabilities Setting the Port Capabilities
portMode Specifying Speed, Duplex and Autonegotiation Mode
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Setting Up Aggregated Links Manually

Aggregated links are connections that allow devices to communicate using up to four
links in parallel. Aggregated links provide two benefits:

They can potentially double, triple or quadruple the bandwidth of a connection.
They can provide redundancy — if one link is broken, the other links share the
traffic for that link.

You can manually set up aggregated links for the Switch using the Add Port window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Bridge -> Link Aggregation -> Modify -> Add Port in the Navigation
Tree.

The Add Port window is displayed.

The Add Port window contains the following elements:

Select an Aggregated Link: 
Allows you to select the aggregated link to set up. Only links that are not already
full are available for selection.

 If all aggregated links are full then the message All Aggregated Links are full.
You cannnot add any ports is displayed when you try to open the Add Port
window.

Select a Unit and Port:
Allows you to select the port to be placed in the aggregated link. To do this: 

1. From the Unit listbox, select a unit. The Switch is displayed in the listbox.
When a unit is selected, the Port listbox is updated to display only the ports
in that unit that can be added to aggregated links.

2. From the Port listbox, select a port.

3. Click OK. The port is assigned to the aggregated link and the Add Port
window is closed.
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Related Operations

Admin State Modifying the Administrative State of an Aggregated Link
LACP State Enabling or Disabling Link Aggregation Control Protocol (LACP)
Partner ID Setting or Modifying the Partner ID for an Aggregated Link
Remove Port Removing a Port from an Aggregated Link Manually
Summary Displaying Summary Information for an Aggregated Link
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Modifying the Administrative State of an Aggregated Link

Aggregated links are connections that allow devices to communicate using up to four
links in parallel. Aggregated links provide two benefits:

They can potentially double, triple or quadruple the bandwidth of a connection.
They can provide redundancy — if one link is broken, the other links share the
traffic for that link.

You can modify the administrative state of an aggregated link using the Admin State
window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Bridge -> Link Aggregation -> Modify -> Admin State in the Navigation
Tree.

The Admin State window is displayed.

The Admin State window contains the following elements:

Link 
Allows you to select the aggregated link to modify.

State Disabled / Enabled
Allows you to modify the state of the aggregated link.

 The current state of the link is intially displayed in the State listbox.

Related Operations

AddPort Adding a Port to an Aggregated Link Manually
LACP State Enabling or Disabling Link Aggregation Control Protocol (LACP)
Partner ID Setting or Modifying the Partner ID for an Aggregated Link
Remove Port Removing a Port from an Aggregated Link Manually
Summary Displaying Summary Information for an Aggregated Link
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Enabling or Disabling LACP on a Port

You can enable or disable Link Aggregation Control Protocol (LACP IEEE Std 802.3-2002,
incorporating 802.3ad) on individual ports on all units in a Distributed Fabric using LACP
window.

 You can only enable or disable LACP on physical ports rather than logical bridge
ports. Hence aggregated links do not appear at the port list prompt.

To access the window:

1. Click Device View on the Toolbar.

2. Select Bridge -> Link Aggregation -> Modify -> LACP State in the Navigation
Tree.

The LACP window is displayed.

The LACP window contains the following elements:

Select a Port and LACP:
Allows you to select the port(s) to have LACP enabled or disabled. To do this: 

1. From the Port listbox, select a port, or select all to enable or disable LACP
across the Switch.

2. From the LACP listbox, select enabled or disabled.

3. Click OK. The port(s) have LACP enabled or disabled and the LACP window is
closed.

Related Operations

AddPort Adding a Port to an Aggregated Link Manually
Admin State Modifying the Administrative State of an Aggregated Link
Partner ID Setting or Modifying the Partner ID for an Aggregated Link
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Remove Port Removing a Port from an Aggregated Link Manually
Summary Displaying Summary Information for an Aggregated Link
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Removing a Port from an Aggregated Link

Aggregated links are connections that allow devices to communicate using up to four
links in parallel. Aggregated links provide two benefits:

They can potentially double, triple or quadruple the bandwidth of a connection.
They can provide redundancy — if one link is broken, the other links share the
traffic for that link.

You can remove a single port from an aggregated link using the Remove Port window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Bridge -> Link Aggregation -> Modify -> Remove Port in the Navigation
Tree.

The Remove Port window is displayed.

The Remove Port window contains the following elements:

Select an Aggregated Link: 
Allows you to select the aggregated link from which the port is to be removed.
Only non-empty links are available for selection. When an aggregated link is
selected, the Select the Port you wish to remove listbox is updated to display only
the ports in that link that can be removed.

 If all aggregated links are empty then the message All Aggregated Links are
empty. You cannnot remove any ports is displayed when you try to open the
Remove Port window.

Select the Port you wish to remove.
Allows you to select the port to be removed from the aggregated link. Click OK.
The port is removed from the aggregated link and the Remove Port window is
closed.

Related Operations
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Displaying Summary Information for Aggregated Links

Aggregated links are connections that allow devices to communicate using up to four links in parallel.
Aggregated links provide two benefits:

They can potentially double, triple or quadruple the bandwidth of a connection.
They can provide redundancy — if one link is broken, the other links share the traffic for that
link.

You can display summary information for an aggregated link using the Summary window.

To access the window:

1. Click Device View on the Toolbar.

2. Select Bridge -> Link Aggregation -> Summary in the Navigation Tree.

The Summary window is displayed.

The Summary window contains the following elements:

Select an Aggregated Link: 
Allows you to select the aggregated link for which you want to display summary information.

When an aggregated link is selected, a list of all the ports in the link is displayed. The mode
and status of each occurrence is also shown.

 If the aggregated link is empty then the message No ports in this Link is displayed.

Related Operations

AddPort Adding a Port to an Aggregated Link Manually
Admin State Modifying the Administrative State of an Aggregated Link
LACP State Enabling or Disabling Link Aggregation Control Protocol (LACP)
Partner ID Setting or Modifying the Partner ID for an Aggregated Link
Remove Port Removing a Port from an Aggregated Link Manually
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